
Design Guide: TIDA-010062
LFU 対応、1kW、80 Plus Titanium、GaN CCM トーテム・ポー
ル・ブリッジレス PFC およびハーフ・ブリッジ LLC のリファレンス・
デザイン

概要

このリファレンス・デザインは、サーバー電源 (PSU) とテレ

コム整流器の各アプリケーションに適した、デジタル制御
の小型 1kW AC/DC 電源のデザインです。この高効率の

デザインは、フロントエンドの連続導通モード (CCM) トー

テム・ポール・ブリッジレス力率補正 (PFC) 段を含め、2 
個のメインの電力段をサポートしています。広い負荷範囲
にわたって高い効率を実現し、80 Plus Titanium 要件を

満たすため、テキサス・インスツルメンツのドライバ内蔵 
LMG341x 窒化ガリウム (GaN) FET を PFC 段に採用し

ています。また、このデザインは LMG3422 GaN FET ハ
ーフ・ブリッジ・インダクタ間コンデンサ (LLC) 絶縁型 

DC/DC 段もサポートしており、DC +12V 出力で 1kW を
供給します。2 枚の制御カードは C2000™ Piccolo™ マイ

コンを使用して、両方の電力段を制御します。

リソース

TIDA-010062 デザイン・フォルダ

TMS320F280049、TMS320F280025 プロダクト・フォルダ

TMS320F280039、TMDSFSIADAPEVM プロダクト・フォルダ

LMG3410、TMCS1100、LMG3422 プロダクト・フォルダ

ISO7721、INA180、ISO7742、OPA2376 プロダクト・フォルダ

TPS560430、UCC27524、UCC28911 プロダクト・フォルダ

テキサス・インスツルメンツの TI E2E™ サ
ポート・エキスパートにお問い合わせくださ
い

特長

• 80 Plus Titanium の効率、20%～100% の負荷範囲

で η ≧ 95%
• CCM GaN ベースのトーテム・ポール・ブリッジレス 

PFC 段は、LMG341x GaN FET と統合型ドライバの

組み合わせで、98.8% を上回るピーク効率を達成

• ハーフ・ブリッジ LMG342x GaN FET LLC 段により 

98.3% を上回るピーク効率

• 高速な負荷過渡応答：2.5A/μs のスルーレートで Vo 
変動は 300mV 未満

• 低い iTHD：10% 負荷で 10% 未満、20% 負荷で 5% 
未満、50% を超える負荷で 2% 未満

• 電力密度 41W/in3、
38mm × 66mm × 160mm

• 高速シリアル・インターフェイス (FSI) ベースの PFC、

DC/DC 通信機能

• ハーフ・ブリッジ LLC (F28003x) のライブ・ファームウ

ェア・アップデート (LFU)

アプリケーション

• 商用ネットワークとサーバーの PSU (電源)
• 商用テレコム整流器

• 産業用 AC/DC
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1 システムの説明

ネットワーク、サーバー、およびデータセンター・システムでは、全負荷範囲の電源 (PSU) にわたって高効率が重要な要

件となります。サーバー・コンピュータは計算と通信のため高い消費電力で継続動作しているため、高効率の PSU を使

用すると運用投資を削減できます。80 PLUS® は、コンピュータの PSU での効率的なエネルギー使用を促進することを

目的とした自主的な認証プログラムです。このプログラムは、定格負荷の 20%、50%、100% でエネルギー効率が 80% 
を超える製品を認定します。最高レベルは Titanium レベルに達しました。

このリファレンス・デザインは、商用サーバー PSU アプリケーション向けの 1000W AC/DC 電源であり、小型フォーム・フ

ァクタ (160mm × 66mm × 38mm) での高効率動作を実証します。このリファレンス・デザインは、フロント段として連続導

通モード (CCM) トーテム・ポール力率補正 (PFC)、出力段として絶縁型ハーフ・ブリッジ LLC、制御段用にバイアス電力

を生成する 1 次側レギュレーション (PSR) フライバックで構成されています。PFC 段は AC 100V～265V RMS の入力

電圧範囲で動作し、DC 380V バスを生成します。2 段目は絶縁型ハーフ・ブリッジ LLC 段で構成され、公称 12V、84A 
の出力を生成します。

1.1 主なシステム仕様

表 1-1. 主なシステム仕様

パラメータ テスト条件 最小 公称 最大 単位

AC 入力電圧 低ライン 100 115 132 V

AC 入力電圧 高ライン 180 230 264 V

ライン周波数 47 63 Hz

出力電力 高ライン 1000 ワット

出力電力 低ライン 1000 ワット

PF 230Vin、100% 負荷 0.99

iTHD 10% 負荷 10% 未満

100% 負荷 2% 未満

リップルおよびノイズ 12V 主出力 ±120 mV

AC ホールドアップ時間 100% 負荷、Vout レギュレーション範囲内 8 10 mS

出力電圧レギュレーション すべてのラインおよび負荷条件 (±5%) 11.4 12 12.6 V

動的負荷 / 過渡応答 Iout-max の 50%、0.5A/uS、3300uF の容量

性負荷

±5% %

動作時周囲温度 0 25 50 ℃

12V 出力の OCP シャットダウン、ラッチオフ 110 130 Iomax の %

12V 出力の OVP シャットダウン、ラッチオフ 13 14.5 V

OTP 自動リスタート

寸法 (mm) シェルやゴールデン・フィンガーを使用しない 160 × 66 × 38 mm

電力密度 41 W/インチ 3
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2 システム概要

2.1 ブロック図
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図 2-1. TIDA-010062 ブロック図

図 2-1 に、この設計の概略ブロック図を示します。この設計では、PFC 段と LLC 段のコントローラにそれぞれ 2 枚の 

TMS320F280039、TMS320F280049、または TMS320F280025 C2000™ Piccolo™ 制御カードを使用し、トーテム・ポ

ールのハーフブリッジ・スイッチングに 1 枚の LMG3410 GaN ドーター・カードを使用します。UCC27714 ハーフブリッ

ジ・ドライバによって駆動されるシリコン MOSFET ベースの同期整流器により、入力の低周波数ハーフ・ブリッジでの電力

損失を低減します。LMG3422 GaN FET 同期整流器は、LLC ハーフブリッジ・スイッチングの ISO7721 アイソレータによ

って駆動されます。入力電流はホール効果センサ （TMCS1100） によって検出され、DC リンク電圧は低電流レベルでの

精度向上を目指し OPA237 アンプを使用して構築された可変ゲイン・アンプ段によって処理されます。出力電流は、

INA180 電流センス・アンプによって検出されます。1 次側と 2 次側の制御カード間の通信のため、4 チャネル・デジタ

ル・アイソレータ ISO7742 によって高速シリアル・インターフェイス （FSI） が検出されます。UCC28911 を使用してオンボ

ードの補助電源を実装し、1 次側に 12V バイアス、2 次側に 6V バイアスを供給します。TPS560430 は、制御カードと制

御回路で、調整された VCC の 1 次側と 2 次側の両方で使用されます。

2.2 設計上の考慮事項

GaN (窒化ガリウム) を活用するトーテム・ポール PFC 段では、スイッチング損失と逆回復損失が大幅に低減されます。

CCM 制御を高効率で実装できます。C2000 の高分解能 PWM 制御と強力な計算能力を活用する LLC 段では、1 次側

と 2 次側の両方で、正確なデッドタイムと SR 制御によるソフト・スイッチングを実現できます。

さらに高効率を実現するために、このデザインの LLC 段はトランスのインターリーブ構造を使用して近接効果を低減し、

PCB 巻線と銅製ストリップを並列に使用して 2 次側の巻線損失を低減しています。LLC トランスでは、SR MOSFET とデ

ュアル・チャネル・ドライバを使用した 4 つの 2 次 PCB 巻線が並列に接続され、3 つの 1 次巻線が直列に接続されてい
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ます。これらの巻線は接続接合部ではありませんが、3 つの巻線はすべて同じねじれを使用します。詳細な設計について

は、この設計のトランス・ベンダである ASIAINFO® の資料を参照してください。

2.3 主な使用製品

このリファレンス・デザインは、次の主な製品を使用しています。このリファレンス・デザインで使用するデバイスを選択する
ための主な機能について説明します。主な使用デバイスの完全な詳細は、それぞれの製品データシートで参照されてい
ます。

2.3.1 LMG3422R050 — ドライバと保護機能を内蔵した 600V GaN

ドライバおよび保護機能を内蔵した LMG342xR050 GaN FET を使うと、設計者はパワー・エレクトロニクス・システムにお

いて、比類ない電力密度と効率を実現できます。LMG342xR050 は、最大 150V/ns のスイッチング速度を実現できるシ

リコン・ドライバを内蔵しています。テキサス・インスツルメンツの統合型高精度ゲート・バイアスは、ディスクリート・シリコン・
ゲート・ドライバと比較して、より広いスイッチング SOA をもたらします。この統合とテキサス・インスツルメンツの低インダク

タンス・パッケージの組み合わせにより、ハード・スイッチング電源トポロジでもノイズの少ないスイッチングとリンギングの最
小化を実現できます。調整可能なゲート・ドライブ強度により、20V/ns～150V/ns までのスルーレートの制御が可能で、

EMI のアクティブ制御とスイッチング性能の最適化に使用できます。LMG3425R050 は理想的なダイオード・モードを備

えているため、アダプティブ・デッドタイム制御が可能で、第 3 象限の損失を低減します。高度な電源管理機能として、デ

ジタル温度通知とフォルト検出を備えています。GaN FET の温度は可変デューティ・サイクル PWM 出力により通知され

るため、デバイスの負荷の管理が簡単になります。報告されるフォルトには、過熱、過電流、UVLO の監視があります。

2.3.2 TMCS1100 — 高精度絶縁型電流センス・モニタ

TMCS1100 は、高精度、優れた直線性、全温度範囲での安定性を備えた絶縁型双方向ホール効果電流センサです。

低ドリフトで、温度補償された信号チェーンにより、デバイスの温度範囲全体にわたって、フルスケールで 1% 未満の誤差

に抑えています。出力電圧は入力電流に比例しており、次の 4 種類の感度から選択できます。50mV/A、100mV/A、

200mV/A、400mV/A。

TMCS1100 は 3V～5.5V の単一電源で動作し、最大消費電流は 5mA です。すべてのバージョンは拡張動作温度範囲 

(40℃～+125℃) で仕様が規定され、8 ピンの SOIC パッケージで供給されます。

2.3.3 UCC27524 — デュアル、5A、高速 2 次側パワー MOSFET ドライバ

UCC2752x ファミリのデバイスは、デュアル・チャネルの高速 2 次側ゲート・ドライバであり、MOSFET および IGBT パワ

ー・スイッチを効果的に駆動できます。本質的に貫通電流を最小限に抑える設計により、UCC2752x は、容量性負荷に

対してソース / シンクともに最大 5A の高いピーク電流パルスを供給できます。また、レール・ツー・レールの駆動能力を持

ち、伝搬遅延は標準値で 13ns と非常に小さくなっています。さらに、ドライバは 2 つのチャネル間の整合内部伝搬遅延

を特長としています。これらの遅延は、同期整流器など、タイミングが重要なデュアル・ゲート・ドライブを必要とするアプリ
ケーションに非常に適しています。また、2 つのチャネルを並列接続して実質的な電流駆動能力を高めることも、1 つの入

力信号で 2 つのスイッチを並行して駆動することも可能です。入力ピンのスレッショルドは、TTL および CMOS 互換の低

電圧ロジックに基づき、VDD 電源電圧に依存しない固定値となっています。上限と下限のスレッショルド間に幅広いヒステ

リシスが設けられているため、優れたノイズ耐性が得られます。

2.3.4 UCC27714 — 620V、1.8A、2.8A 1 次側 / 2 次側ゲート・ドライバ

UCC27714 は、4A のソース / シンク電流容量を備えた 600V 1 次側 / 2 次側ゲート・ドライバであり、パワー MOSFET 
や IGBT の駆動に適しています。このデバイスは、1 つの GND 基準チャネル (LO) と 1 つのフローティングチャネル 

(HO) で構成され、ブートストラップ電源で動作するように設計されています。堅牢性とノイズ耐性に優れており、HS ピン

で最大 DC -8V (VDD = 12V) の負電圧に対しても動作ロジックを保持できます。

2.3.5 ISO7721 — 高速、堅牢な EMC 特性、強化絶縁型、基本デュアル・チャネル・デジタル・アイソレータ

ISO7721x デバイスは、UL 1577 に準拠した 3000VRMS (D パッケージ) の絶縁定格を持つ高性能デュアル・チャネル・

デジタル・アイソレータです。ISO7721x デバイスは、CMOS または LVCMOS デジタル I/O を絶縁しながら、低消費電

力で高い電磁気耐性と低い放射を実現します。各絶縁チャネルは、二酸化ケイ素 (SiO2) の二重の容量性絶縁バリアで

分離されたロジック入力および出力バッファを備えています。ISO7721x デバイスには、順方向と逆方向のチャネルがあり

システム概要 www.ti.com/ja-jp

4 LFU 対応、1kW、80 Plus Titanium、GaN CCM トーテム・ポール・ブリッジレス PFC 
およびハーフ・ブリッジ LLC のリファレンス・デザイン

JAJU751G – SEPTEMBER 2019 – REVISED OCTOBER 2023
資料に関するフィードバック (ご意見やお問い合わせ) を送信

English Document: TIDUET7
Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com/ja-jp
https://www.ti.com/ja-jp/lit/pdf/JAJU751
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU751G&partnum=TIDA-010062
https://www.ti.com/lit/pdf/TIDUET7


ます。入力電力または入力信号が失われた場合のデフォルト出力は、接尾辞 F のないデバイスでは HIGH、接尾辞 F の
あるデバイスでは LOW です。

2.3.6 ISO7740 および ISO7720 — 高速、低消費電力、堅牢な EMC デジタル・アイソレータ

ISO774x デバイスは、高性能のクワッド・チャネル・デジタル・アイソレータであり、UL1577 準拠で 5000VRMS (DW パッ

ケージ) および 3000VRMS (DBQ パッケージ) の絶縁定格を備えています。このファミリのデバイスは、VDE、CSA、

TUV、CQC に従って絶縁定格が強化されています。ISO774x デバイスは、CMOS または LV CMOS デジタル I/O を絶

縁しながら、低消費電力で高い電磁気耐性と低い放射を実現します。各絶縁チャネルは、シリコンダイオード (SiO2) の
二重の容量性絶縁バリアで分離されたロジック入力および出力バッファを備えています。このデバイスにはイネーブル・ピ
ンがあり、対応する出力を高インピーダンスに移行して、マルチマスタ駆動アプリケーションや、消費電力の低減に使用で
きます。ISO7740 デバイスは 4 チャネルすべてが同じ方向であり、ISO7741 デバイスには 3 つの順方向チャネルと 1 つ
の逆方向チャネル、ISO7742 デバイスには 2 つの順方向チャネルと 2 つの逆方向チャネルがあります。入力電力または

入力信号が失われた場合のデフォルト出力は、接尾辞 F のないデバイスでは HIGH、接尾辞 F のあるデバイスでは 

LOW です。

2.3.7 OPA237 — 単一電源オペアンプ

OPA237 オペアンプ・ファミリは、テキサス・インスツルメンツのマイクロ・アンプの 1 つであり、一連の小型製品で構成され

ています。これらのデバイスは小型サイズに加えて、低オフセット電圧、低静止電流、低バイアス電流、広い電源電圧範囲
を特長としています。単一電源アプリケーションに理想的です。単一電源で動作している場合、入力同相範囲はグランド
を下回り、出力はグランドから 10mV 以内で変動します。

2.3.8 INAx180 — 2 次側および 1 次側電圧出力、電流センス・アンプ

INA180、INA2180、INA4180 (INAx180) 電流センス・アンプは、コスト最適化されたアプリケーション用に設計されていま

す。これらのデバイスは、電流センス・アンプ (電流シャント・モニタとも呼ばれます) のファミリに属し、電源電圧にかかわら

ず、-0.2V～+26V の同相電圧において、電流センス抵抗の両端の電圧降下を検出できます。INAx180 は、整合抵抗ゲ

イン回路を、4 つの固定ゲイン・デバイス・オプション(20V/V、50V/V、100V/V、または 200V/V) に統合しています。この

整合ゲイン抵抗回路により、ゲイン誤差が最小限に抑えられ、温度ドリフトが低減されます。

これらのデバイスはすべて、単一の 2.7V～5.5V 電源で動作します。最大消費電流は、シングル・チャネルの INA180 は 

260μA で、デュアル・チャネルの INA2180 は 500μA、クワッド・チャネルは 900μA です。

INA180 は 5 ピンの SOT-23 パッケージで供給され、2 種類のピン構成から選択できます。INA2180 は 8 ピンの 

VSSOP パッケージで供給されます。INA4180 は 14 ピンの TSSOP パッケージで供給されます。すべてのデバイス・オ

プションは、拡張動作温度範囲の -40℃～+125℃ で動作が規定されています。

2.3.9 TPS560430 — SIMPLE SWITCHER® 4V～36V、600mA、同期整流降圧コンバータ

TPS560430 は使いやすい同期整流降圧 DC/DC コンバータで、最大 600mA の負荷電流を駆動できます。このデバイ

スは 4V～36V の広い入力電圧範囲で動作し、産業用から車載用まで、非レギュレーション電源からの電源調整を行うさ

まざまなアプリケーションに適しています。

TPS560430 には 1.1MHz と 2.1MHz のバージョンの動作周波数があり、高効率またはソリューションの小型化を実現で

きます。また、TPS560430 には FPWM (強制 PWM) バージョンがあり、一定の周波数を維持しながら、負荷範囲全体に

わたって出力電圧リップルを小さくできます。ソフトスタートと補償回路が内部に実装されており、最小限の外付け部品の
みでデバイスを使用できます。

このデバイスには、サイクル単位の電流制限、ヒカップ・モード短絡保護、過剰な電力消費時のサーマル・シャットダウンな
どの保護機能が組み込まれています。TPS560430 は、SOT-23-6 パッケージで供給されます。

2.3.10 TLV713 — ポータブル機器向けフォールドバック電流制限付き 150mA 低ドロップアウト (LDO) レギュレータ

TLV713 シリーズの LDO (低ドロップアウト) リニア・レギュレータはラインおよび負荷過渡性能が非常に優れた低静止電

流 LDO であり、電力の制約が厳しいアプリケーション用に設計されています。これらのデバイスの精度は 1% (標準値) 
です。
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TLV713 シリーズのデバイスは、出力コンデンサなしで安定するように設計されています。出力コンデンサが必要ないた

め、非常に小型のソリューションが可能です。しかし、出力コンデンサを使用した場合も、TLV713 シリーズは任意の出力

コンデンサで安定します。

また TLV713 は、デバイスの電源投入およびイネーブル時に突入電流の制御も行います。TLV713 は定義済みの上限

値に入力電流を制限し、入力電源から大電流が流れ込むことを防止します。この機能は、バッテリで動作するデバイスで
は特に重要です。

TLV713 シリーズは、標準の DQN および DBV パッケージで供給されます。TLV713P は、出力負荷をすばやく放電する

ためのアクティブ・プルダウン回路を備えています。

2.3.11 TMP61 — 温度検出向けシリコン・ベース小型リニア・サーミスタ

TMP61 シリーズの小型シリコンのリニア・サーミスタは、温度測定、保護、補償、制御の各システム用に設計されていま

す。従来の NTC サーミスタと比較して、TMP61 では全温度範囲にわたって高い線形性と安定した感度が得られます。

TMP61 は、デバイスが環境の変動に対する耐性を持つことと、高温におけるフェイルセーフ動作が内蔵されていることか

ら、安定した性能を実現します。現在、このデバイスは 2 ピンの表面実装 0402 フットプリント互換 X1SON パッケージで

供給されています。

2.3.12 CSD18510Q5B — 40V、N チャネル NexFET™ MOSFET、シングル SON5x6、0.96mΩ

この 40V、0.79mΩ、SON 5mm × 6mm の NexFET™ パワー MOSFET は、電力変換アプリケーションでの損失を最小

限に抑えるように設計されています。

2.3.13 UCC28911 — 定電圧、定電流、1 次側レギュレーション付き 700V フライバック・スイッチャ

UCC28910 および UCC28911 は高電圧のフライバック・スイッチャで、光カプラを使用せずに出力電圧と電流のレギュレ

ーションを行います。どちらのデバイスも、700V のパワー FET とコントローラを内蔵しており、フライバック補助巻線とパワ

ー FET からの動作情報を処理して、高精度の出力電圧と電流制御を実現します。起動用の内蔵高電圧電流源はデバイ

ス動作中にオフになり、コントローラの消費電流は負荷に応じて動的に調整されます。どちらも、スタンバイ時の消費電力
を非常に低く抑えることができます。

UCC28910 および UCC28911 の制御アルゴリズムは、スイッチング周波数とピーク 1 次側電流変調を組み合わせてお

り、適用される規格を満たすか上回る動作効率を実現できます。バレー・スイッチング付き不連続導通モード (DCM) を使

用して、スイッチング損失を低減します。内蔵保護機能により、動作範囲全体にわたって 2 次側と 1 次側の部品のストレ

ス・レベルをチェックできます。周波数ジッタは、EMI フィルタのコスト削減に役立ちます。

2.3.14 SN74LVC1G3157DRYR — 単極双投アナログ・スイッチ

このシングル・チャネル単極双投 (SPDT) アナログ・スイッチは、1.65V～5.5V の VCC で動作するように設計されていま

す。SN74LVC1G3157 デバイスは、アナログとデジタルの両方の信号を扱うことができます。SN74LVC1G3157 デバイス

は、最高で VCC (ピーク) までの振幅の信号を、どちらの方向にも転送できます。信号ゲーティング、チョッピング、変調ま

たは復調 (モデム)、およびアナログ / デジタルやデジタル / アナログ変換システム用の信号多重化などのアプリケーショ

ンに使用できます。
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2.4 システム設計理論

このリファレンス・デザインは、12V と 84A で AC 電源を使用するユニバーサルな公称出力 1000W を供給します。この

デザインは、フロント・エンドのトーテム・ポール PFC 電力段と、絶縁型 DC/DC LLC 電力段で構成されています。

2.4.1 トーテム・ポール PFC 段の設計

トーテム・ポール・ブリッジレス PFC は長年にわたって提示されてきた古い構造ですが、MOSFET のボディ・ダイオードの

逆回復性能が低いため、製品には採用されていませんでした。ただし、近年、GaN HEMT の逆回復機能を利用していな

いことから、トーテム・ポール PFC が採用され、シンプルな構造になってきました。一般に、トーテム・ポール PFC には 1 
つの高速スイッチング・レッグと 1 つの低速スイッチング・レッグがあります。低速スイッチング・レッグは、整流ダイオードま

たは MOSFET の両方を使用できます。MOSFET を低速スイッチング・レッグとして使用する場合、トーテム・ポール PFC 
は AC 側と DC 側の間で、より高効率と双方向電力変換を実現できます。

2.4.1.1 PFC 段の設計パラメータ

表 2-1. PFC 段の設計パラメータ

記号 パラメータ 最小 公称 最大 単位

VIN AC 入力電圧 100 230 264 AC V

fline ライン周波数 47 63

Vout 出力電圧 385 DC V

Pout (nom) 出力電力 1050 ワット

η 目標効率 98.8%

iTHD 目標入力電流 THD 30% を超える負荷で 

5% 未満

PF 目標力率 0.99

Fsw スイッチング周波数 100 kHz

2.4.1.2 電流の計算

入力ヒューズ、ブリッジ整流器、および入力コンデンサは入力電流の計算に基づいて選択されます。まず、式 1 にしたが

って最大平均出力電流、IOUT(max) を決定します。

�
   �

�

OUT(max)
OUT(max)

dc _ link

P 1050 W
I 2.73 A

V 385 V (1)

最大入力 RMS ライン電流、IIN_RMS(max) は表 2-1 のパラメータを使用して計算され、効率と力率の初期仮定は次のよう

に計算されます。

OUT(max)
INrms(max)

PFC IN(min)

P 1050 W
I 10.8 A

V PF 98% 100 V 0.99

�
   �
K u u u � u (2)

2.4.1.3 PFC 昇圧インダクタ

昇圧インダクタを決定するには、まず最大許容リップル電流を計算します。最小入力電圧と最大負荷で最大リップル電流
が観測されます。インダクタ電流に最大 40% のリップルを想定すると、リップル電流は次のように計算されます。

 ' u  u u  �INripple(max) INrms(max)I ripple I 0.2 2 10.7A 6.06 A (3)

最小入力電圧のピーク時のデューティ・サイクル DUTY(max) は、次のように計算できます。

OUT(max) INmin 2
(max)

dc _ link

V V 385 V 100 V 2
DUTY 0.63

V 385 V

u
� � � � � u �

   

� (4)
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昇圧インダクタの最小値は、許容されるリップル電流に基づいて計算され、ワーストケースのデューティ・サイクルは 0.63 
です。

�
t u u  �P

u

(max)
Boost OUT(max) (max)

INripple(max)

1 DUTY
L V DUTY 295 H

FSW I (5)

選択したインダクタの実際の値は 300μH です。昇圧インダクタに必要な飽和電流は、最小入力電圧と短時間最大過負

荷状態に対して式 6 を使用して計算されます。

'
 u u �  �

OUT(max)
L(max)

INrms(min)

P ripple0
I 2 (1 ) 16.67 A

V 2 (6)

2.4.1.4 出力コンデンサ

出力コンデンサ Cbus は、コンバータの DC リンク・リップルおよびホールドアップ要件を満たすようにサイズ設定されてい

ます。

DC リンク電圧のリップルは式 7 で計算できます。

u
 

u

OUT
ripple

bus Bus

P 0.0032
V

C V (7)

この設計で必要なホールドアップ時間 THoldup は 10ms です。平均バス電圧は 385V に設定され、LLC トランス比と相関

します。全負荷時の DC リンク電圧のリップルが +/-10V であることを考慮すると、バレー・ポイントでの DC BUS 電圧は 

VBUS(norm) = 365V になります。

LLC のゲインが大きすぎないことを考慮すると、LLC の最小入力は VBUS(min) = 320V に設定されます。エネルギーにつ

いては、式 8 を使用して、バス容量の最小値を計算できます。式 9 の計算では、使用可能な容量値として 680uF を選択

しました。

t u u

�

Holdup
OUT OUT(nominal) 2 2

OUT(norm) OUT(min)

T
C 2 P

V V (8)

OUT 2 2

10 ms
C 2 1000 W 648 F

365 V 320 V

�
t u � u  �P

� � � (9)

2.4.1.5 高速および低速スイッチ

IIN_RMS(max) の計算から、スイッチのすべての電流定格は 10.8A を上回る必要があります。CCM トーテム・ポール PFC 
では、高速ブリッジに GaN スイッチが必要です。70mΩ の GaN LMG3410R070 が選択されました。これは、125℃の Tj 
で 12A の IDS を使用する場合に推奨されます。

低速ブリッジはライン周波数のスイッチングのみであるため、効率を向上させるには最小 RDS(on) が推奨されます。スペー

スを節約するために、Toshiba® 50mΩ MOSFET TK39A60W が選択されました。このデバイスには低 RDS(on) があり、

市場で TO220 パッケージで供給されます。

2.4.1.6 AC 電流検出回路

この設計では、電流ループ制御のために AC 電流が検出されます。CCM 昇圧 PFC 制御ループでは、平均電流のみが

必要です。TMCS1100 は 120kHz のホール・センサで、この設計に最適なオプションです。TMCS1100 は全動作温度

範囲にわたって高精度を維持し、オフセット電流ドリフトが非常に小さいため、入力電力測定の精度を達成できます。

TMCS1100 には次の 4 つのオプションがあります。50mV/A、100mV/A、200mV/A、400mV/A。電源電圧は 3V～5.5V 
です。オフセット電圧は外部で設定されます。この設計では 1.65V が選択されており、これはコントローラの VCC の半分

です。最大入力電流は、ピーク値で 14A に達します。ワーストケースを考慮し、ある程度のマージンを残すために、
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TMCS1100A1 を選択しました。この検出回路は、OPA376 と 1 つのアナログ・スイッチ SN74LVC1G3157 を使用して、

低ラインと高ラインの両方で ADC 範囲に一致するように電圧をスケーリングしました。回路を図 2-2 に示します。

Hall Sensor
+

GND

CLPF

Re

SW Rf

Rf

Vref

RLPF
±

Iac

f
ref hall

f

ref hall

R 1
V G ,if sw off

Re 1 RC s
sense R

12 V G ,if sw on
Re 1 RC s

I (S)

§ ·
� u u � �¨ ¸ � �© ¹

§ ·
¨ ¸

� u u � �¨ ¸
� �¨ ¸¨ ¸

© ¹

­
°
°
°

 ®
°
°
°̄

図 2-2. 電流検出および信号スケーリング回路

2.4.1.7 温度検出

テキサス・インスツルメンツのシリコン・ベースのリニア・サーミスタ TPM61 は、温度検出に使用されます。実装回路を図 

2-3 に示します。

RBIAS

VBIAS

VTEMPRTMP61

IBIAS

VTEMPRTMP61

+

±�

+

±�

u
 

�

Bias TMP61
Temp

Bias TMP61

V R
V

R R
 uTemp Bias TMP61V I R

図 2-3. 温度検出回路

2.4.2 LLC 段の設計パラメータ

LLC 段は、出力レギュレーションの最終段です。その入力は PFC 段の出力であるため、LLC 段は AC 電圧降下が発生

したときのホールドアップ時間の全負荷時のピーク値である VBUS(max) と最小 VBus 電圧である VBUS(min) の間の 12V で
出力電圧を安定させておく必要があります。

表 2-2. LLC 段の設計パラメータ

記号 パラメータ 最小 公称 最大 単位

VIN DC 入力電圧 320 385 395 DC V

Vout 出力電圧 11.4 12 12.6 DC V

Pout 最大出力電力 1000 ワット

fsw スイッチ周波数 80 140 250 kHz

η 目標効率 98 %

2.4.2.1 LLC トランスの巻線比 N の決定

LLC タンクは、共振周波数での公称ゲイン Mg を 1 とするように設計されています。式 10 を使用して、必要な巻線比を

推定します。
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�
   

u u �

BUS(nom)

out(norm)

V 385 V
n 16

2 V 2 12.0 V (10)

トランスの巻線比は 16 に設定されています。

2.4.2.2 Mg_min と Mg_max の決定

それぞれ式 11 と式 12 を使用して Mg_min と Mg_max を決定します。

� � � �
 u  u  

�

O F
g _ min

bus(max)

V V 12 V 0.01V
M n 16 0.972

V / 2 395 V / 2 (11)

O F
g_max

bus(min)

V V 12 V 0.01V
M n 16 1.2

V / 2 320 V / 2

� � � �
 u  u  

� (12)

寸法が指定された Mg_max が 1 に増加します。マージンを確保するために必要な値の 1 倍は、Mg_max = 1.1 × 1.2 ≒ 
1.3 です。

2.4.2.3 共振ネットワークの等価負荷抵抗 (Re) の決定

式 13 は、公称出力電圧とピーク出力電圧の下で、公称負荷とピーク負荷の等価負荷抵抗を計算します。

u u
 u  u  �:

S S

2 2
O

e 2 2
O

V8 n 8 16 12
R 29.64

I 84 (13)

2.4.2.4 Lm と Lr の比率 (Ln) と Qe の選択

LLC トランス・セットの寸法を最小化するために、LLC コンバータの共振ポイントを 140kHz 付近に設定します。LLC 電力

段の動作ポイントは、全負荷状態でこの周波数に近い値になります。次のように、Lr = 19μH および Cr = 66nF の値を選

択して、共振周波数の値を計算します。

  �

S
r

r r

1
f 140 kHz

2 L C (14)

PQ 32/30 コアを使用して、LLC トランスを実現しています。共振インダクタンスは、20/16 PQ コア上に構築された追加の

シム・インダクタによって提供されます。

2.4.2.5 1 次側電流の決定

式 15 を使用して、全負荷条件での 1 次側 RMS 負荷電流 (Ipri) を計算します。

o(nom)
pri

I 84
I 1.11 5.83 A

n 162 2

S
 u  u  �

(15)

式 16 で計算したように、fSW_min = 140kHz 時の RMS 磁化電流 (Im) は次のようになります。

O(norm) F
m

sw(min) m

V V2 2
I n 0.66 A

2 f L

§ ·�
 u  �¨ ¸

¨ ¸S Su � u© ¹ (16)

式 17 は、共振回路電流 (Ir) を計算します。

 �  �
2 2

r pri mI I I 5.86 A (17)

この値は、fSW_min でのトランスの 1 次巻線電流にも等しくなります。
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2.4.2.6 2 次側電流の決定

2 次側 RMS 電流は、平均負荷電流から計算できます。LLC 電力段が 2 番目の共振周波数付近で動作していると仮定

すると、2 次側プッシュプル出力の各整流器を流れる RMS 電流は式 18 で計算されます。

S
 u  �sec_RMS secI I 92.56 A

2 2 (18)

2.4.2.7 1 次側 GaN / ドライバ

従来型の LLC は基本的に Si MOSFET を使用して達成されています。GaN は適切に冷却されており、入力ピンは電圧

互換の絶縁型ドライブであるため、このリファレンス・デザインは、GaN を電源管として使用することを考慮しており、過熱 

(OT) と過電流 (OC) を区別できます。GaN には温度レポートなどの利点もあり、50mR RDS(on) GaN では 1kW で十分

です。

2 次側の 1 次側 GaN を駆動するには、GaN の異常情報を取得できる 2 個の ISO7721 アイソレータを使用します。

2.4.2.8 2 次側同期 MOSFET

出力ダイオード整流器 / SR MOSFET の電圧定格は、式 19 で求められます。

 u u  �dsmax o(nom)V 1.2 2 V 28.8 V (19)

出力 SR MOSFET を流れる RMS 電流は、式 20 で与えられます。

�
 u   �SRMOS _RMS sec_RMS

1 92.56 A
I I 46.28 A

2 2 (20)

同期整流器の損失を低減するために、RDS(on) と Qg が非常に小さい 4 個の CSD18510Q5B を並列に使用していま

す。各 MOSFET は、LLC 出力段の導通損失を低減するために、1 つのデュアル・チャネル非絶縁型ドライバである 

UCC27524 を使用しました。

2.4.2.9 出力電流検出

この設計では、出力電流を検出してシステム効率を最適化し、デッドタイムと SR パルスを調整して、複数の PSU 間で電

流共有制御を行います。また、この信号を LLC 段の制御ループで使用して、負荷過渡時のオーバーシュートとアンダー

シュートを低減することもできます。

INAx180 の高い同相範囲の利点は、検出抵抗を 1 次側 VO+ または 2 次側 VO- に配置できることです。INAx180 は、

整合抵抗ゲイン回路を 4 つの固定ゲイン・デバイス・オプション 20、50、100 および 200 に内蔵しています。 この整合ゲ

イン抵抗回路により、ゲイン誤差が最小限に抑えられ、温度ドリフトが低減されます。電流検出抵抗の電力損失を低減す
るには、200V/V A4 デバイスを選択し、電圧がマイコンの ADC 範囲に一致するよう抵抗を調整してスケーリングする必要

があります。検出抵抗は、式 21 を使って計算できます。

�
   �� :

u u u � u

ADC
CS

omax

V 3.3 V
R 0.131 m

1.5 I 200 1.5 84 A 200 (21)

抵抗が 1mΩ より小さい場合、精度は低下し、コストは増加します。したがって、0.125mΩ を並列に配置しながら、精度 

1% の 0.5mΩ 抵抗を 4 個使用します。

2.4.3 1 次側と 2 次側の間の通信

この設計では、1 次側と 2 次側の両方で F280049、F280039、または F280025 を使用します。C2000 マイコンで利用

できる高速シリアル・インターフェイス （FSI） 通信は、この設計に最適なオプションです。

FSI は、産業用ドライブやデジタル電源アプリケーションで使用される高電圧システムにおいて、エア・ギャップをまたぐ、

またはホットサイドからコールドサイドへ、またはその逆への高帯域幅デジタル通信のソリューションとして開発されました。
FSI は、LVCMOS IO で最高 50MHz のクロック・レートを達成しており、それぞれの方向でわずか 2 本の CLK とデータの
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ピンを使用できます。FSI にはデュアル・データ・レートもあります。立ち上がりと立ち下がりの両方のクロック・エッジでデー

タをラッチするため、未処理の送信帯域幅は 100Mbps、未処理の受信帯域幅は 100Mbps になります。

強化絶縁が必要な各方向の 2 つの信号の構成は、別のテキサス・インスツルメンツ部品である ISO7742 によって完全に

解決されています。単一の SOIC16 パッケージ ISO7742 は、最大 8000Vpk の 100Mbps FSI 信号を絶縁するために

必要なすべての機能を備え、VDE、CSA、CQC、TUV に準拠した強化絶縁認定を取得しています。このシングル・チッ

プは、FSI を使用する場合、複数の絶縁デバイスのコストを置き換えると同時に、基板面積を大幅に削減し、また、マルチ

プレーンと高電圧 PCB 設計に関連する PCB 配線と電圧プレーン定義の課題を減らすことができます。

3 ハードウェア、ソフトウェア、テスト要件、テスト結果

3.1 必要なハードウェアとソフトウェア

3.1.1 ハードウェア

このセクションでは、TIDA-010062 ボードのテストと検証に必要な機器、テストのセットアップ、および手順の説明を詳しく

説明します。

3.1.1.1 テスト条件

入力の場合、電源 (VIN) の範囲は AC 100V～265V でなければなりません。入力 AC ソースの入力電流制限を 15A に
設定します。出力には、電子可変負荷または可変抵抗性負荷を使用します。この負荷の定格は 15V 以上で、負荷電流

を 0A から 90A に変化させる必要があります

本節では、ハードウェアならびに基板の個々の部位について詳述します。powerSUITE により、このリファレンス・デザイン

のファームウェアを使用する場合には、本節を読み飛ばして構いません。マイコンの PFC 段の制御に使用される主要な

リソースを表 3-1 に示します。マイコンの LLC 段の制御に使用される主要なリソースを表 3-2 に示します。図 3-1 に設計

基板の主要な電力段とコネクタを示します。

図 3-1. 基板の概要

表 3-1. PFC 段：基板の電力段の制御に使用される主要なコントローラ・ペリフェラル

信号名 HSEC ピン番号 機能

PWM-1A 49 PWM：低周波 MOSFET レッグ、1 次側スイッチ

PWM-1B 51 PWM：低周波 MOSFET レッグ、2 次側スイッチ

PWM-3A 50 PWM：高周波 GaN レッグ、1 次側スイッチ。

PWM-3B 52 PWM：高周波 GaN レッグ、2 次側スイッチ。

Iac 18 CMPSS 付き ADC：AC リターン電流測定

VL 20 ADC：AC ライブ側電圧
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表 3-1. PFC 段：基板の電力段の制御に使用される主要なコントローラ・ペリフェラル (続
き)

信号名 HSEC ピン番号 機能

VN 17 ADC：AC ニュートラル側電圧

Vbus 24 ADC：バス電圧

突入リレー 67 GPIO：突入リレーの制御に使用

GaN Fault 56 GPIO：GaN フォルト信号

AC 電流センスのゲ

イン変化

63 GPIO：ゲイン段を制御

表 3-2. LLC 段：基板の電力段の制御に使用される主要なコントローラ・ペリフェラル

信号名 HSEC ピン番号 機能

PWM-1A 49 1 次側 HB の 1 次側駆動信号

PWM-1B 51 1 次側 HB の 2 次側駆動信号

PWM-2A 53 SRA の駆動信号

PWM-2B 55 SRB の駆動信号

VOUT 25 CMPSS 付き ADC：出力電圧測定

IOUT 15 CMPSS 付き ADC：共振電流測定

Ireso 21 CMPSS 付き ADC：出力電流測定

3.1.1.2 ボードの検証に必要なテスト機器

ボードの検証には、次のテスト機器が必要です。

• 絶縁型 AC ソース

• 単相電力アナライザ

• デジタル・オシロスコープ

• 高電圧プローブ (600V 超)
• 電流プローブ

• マルチメータ

• 電子負荷または抵抗性負荷

• 12V1A 冷却ファン

3.1.1.3 テスト方法

3.1.1.3.1 システム・テスト：デュアル段

1. GaN ドーター・カードと C2000 Piccolo controlCard を次のようにマザーボードに接続します。コネクタの各ピンへの

接続の詳細については、「1kW、80+ Titanium AC/DC 電源のリファレンス・デザイン」の回路図を参照してください。

• コネクタ Brd1 位置にある 1 枚の GaN ドーター・カード「LMG3410-HB-EVM」

• コネクタ J1 および J3 の C2000 Piccolo controlCard「TMDSCNCD280049C」/「TMDSCNCD280025C」

2. リファレンス・ボードの 3 ピン AC 端子を AC 電源に接続します。

3. 出力端子を配線で電子負荷に接続し、極性を適切に維持します。

4. 冷却ファンを AC 側に配置し、ボードを風にさらします。

5. 約 10A の小さな負荷を設定および維持します。

6. 電流 / 電圧プローブを接続して入力電流、入力電圧、出力電圧を観測できます。

3.1.1.3.2 PFC 段テスト

1. J6 スロットに制御カードを挿入します。

2. DC 12V、1A 電源を 12Vp、PGND1 ネットで接続します。

3. 12V 電源をオンにします。制御カードの LED が点灯して、デバイスに電源が入ったことを示します。

4. JTAG を接続するには、制御カードから USB ケーブルを使用してホスト・コンピュータに接続します。プロジェクトをビ

ルドして、ロードします。
5. ラボごとに異なる設定があります。
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ラボ 1 では、DC 電源を入力 J7 に接続できます。約 500Ω、400W の負荷抵抗を HVBUS、PGND ネットの出力に

接続する必要があります。

ラボ 2 では、DC 電源を入力 J7 に接続できます。約 100Ω、400W の負荷抵抗を HVBUS、PGND ネットの出力に

接続する必要があります。

ラボ 3 では、単相 AC 電源を入力 J7 に接続できます。約 500Ω、400W の負荷抵抗を HVBUS、PGND ネットの出

力に接続する必要があります。

ラボ 4 では、単相 AC 電源を入力 J7 に接続できます。約 0.2 A、1500W の定電流を HVBUS、PGND ネットの出

力に接続する必要があります。

6.図 3-1 に示すように、電流 / 電圧プローブを接続して入力電流、入力電圧、出力電圧を観測できます。

3.1.1.3.3 LLC 段テスト

1. J2 スロットに制御カードを挿入します。

2. DC 12V、1A 電源を 12Vp、PGND1 ネットで接続します。

3. DC 6V、1A 電源を 6Vcc、V0 ネットで接続します。

4. 12V 電源と 6V 電源の両方をオンにします。制御カードの LED が点灯して、デバイスに電源が入ったことを示しま

す。
5. JTAG を接続するには、制御カードから USB ケーブルを使用してホスト・コンピュータに接続します。プロジェクトをビ

ルドして、ロードします。
6. ラボごとに異なる設定があります。

ラボ 1 では、DC 電源を HVBUS、PGND ネットに接続できます。定電流負荷である約 10A を、12Vout、V0-out ネッ

トで出力に接続する必要があります。

ラボ 2 では、DC 電源を HVBUS、PGND ネットに接続できます。定電流負荷である約 10A を、12Vout、V0-out ネッ

トで出力に接続する必要があります。
7. 図 3-1 に示すように、電流 / 電圧プローブを接続して、共振電流、スイッチング・ノード電圧、SR 駆動信号、出力電

圧を観測できます。

3.1.2 PFC 段ソフトウェア

このリファレンス・デザインのソフトウェアは C2000Ware Digital Power SDK で利用可能であり、powerSUITE フレームワ

ーク内でサポートされています。

3.1.2.1 CCS でのプロジェクトの開始

まず

1. Code Composer Studio (CCS) 統合開発環境 (IDE) ツール・フォルダ (CCSV10.1 以上を推奨) から CCS をイン

ストールします。

2. C2000Ware Digital Power SDK ツール・フォルダの C2000Ware DigitalPower SDK をインストールします。

• 注：デフォルト・インストールでは、SDK とともに powerSUITE がインストールされます。

3. [View] → [Resource Explorer] を選択します。 TI Resource Explorer 下で、C2000Ware DigitalPower SDK を選

択します。

リファレンス・デザイン・ソフトウェアをそのまま開くには (このリファレンス・デザインおよびハードウェアで動作していた

ようにファームウェアが開き、基板はこのリファレンス・デザインと全く同じものにする必要があります)。
4. [C2000Ware DigitalPower SDK] 下で、[Development Kits] → [CCM Totem Pole PFC TIDA-010062] を選択

し、[Run <Import> Project] をクリックします。 
5. これでプロジェクトがインポートされ、開発キットまたは設計ページが表示されます。このページを使用して、このユー

ザー・ガイドやテスト・レポート、ハードウェア設計ファイルなど、リファレンス・デザインに関する情報をすべて参照でき
ます。

6. [Import <device_name> Project] をクリックします。

7. この操作によりプロジェクトがワークスペース環境にインポートされ、図 3-3 のような GUI の main.syscfg ページが表

示されます。
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3.1.2.2 プロジェクト構造

プロジェクトがインポートされると、図 3-2 に示すように CCS 内に Project Explorer が表示されます。

図 3-2. PFC ソリューション・プロジェクトの Project Explorer ビュー
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main.syscfg ファイルをクリックすると、GUI ページが表示され、PFC ソリューションの変更可能なオプションが表示されま

す (図 3-3)。この GUI を使用して定格電力、インダクタンス、容量、検出回路パラメータなど、適合ソリューションのパラメ

ータを変更できます。

図 3-3. CCM TTPL PFC 段の powerSUITE ページ
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プロジェクトの一般構造を図 3-4 に示します。

図 3-4. プロジェクト構造の概要

図 3-4 は F28004x/F28002x/F28003x のプロジェクトを示していますが、powerSUITE ページから別のデバイスを選択

しても、その構造は同様です。

ソリューション別でデバイスに依存しないファイルは <solution>.c/h です。 このファイルはプロジェクトの main.c ファイル

で構成されており、各ソリューションの制御構造に関与します。

この設計のこの段階では、<solution> は ttplpfc です。

基板別でデバイス別のファイルは <solution>_hal.c/h です。このファイルは、各ソリューションを実行するデバイス別ドライ

バで構成されています。

powerSUITE ページは、Project Explorer に表示される main.syscfg ファイルをクリックして開くことができます。

powerSUITE ページでは <solution>_settings.h ファイルが生成されます。このファイルは、powerSUITE ページで生成

されたプロジェクトのコンパイル時に使用する唯一のファイルです。プロジェクトが保存されるたびに powerSUITE によっ

て変更内容が上書きされるため、このファイルを手動で変更しないでください。<solution>_user_settings.h ファイルで、

いくつかの設定を変更できます。

Kit.json ファイルと solution.js ファイルも、powerSUITE により内部で使用されるため、ユーザーが変更することはできま

せん。 これらのファイルを変更すると、プロジェクトが正常に機能しなくなります。

setupdebugenv_build.js は、さまざまなラボで [Watch] ウィンドウの変数を自動入力するために提供されています。

*.graphProp ファイルは、データ・ロガー・グラフの設定を自動入力するために提供されています。

プロジェクトは、PWM サイクルごとに呼び出される割り込みサービス・ルーチン (ISR) で構成されており、この ISR の中で

電流コントローラが実行されます。ほかにも電圧ループおよび計測 ISR を実行するために呼び出される、約 10kHz の低

速 ISR があります。少数のバックグラウンド・タスク (A0-A4 および B0-B4) はポーリング方式で呼び出され、これを使用し

て SFRA バックグラウンドなど、絶対的なタイミング精度が要求されない低速タスクを実行できます。
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図 3-5 にファームウェアのソフトウェア・フローチャートを示します。

Save context and clear interrupts flags

C-ISR

Read ADC result

Run current loop compensator Gi

Run PWM modulator

Run SPLL and calculate current 

reference 

Run adaptive deadtime calc.

Restore context

return

Save context and clear interrupts flags

Enable interrupt EINT

C-ISR

(boost control)

Run notch filter on measure

bus voltage

Run current loop compensator Gv

Run power measurement

Run data logger

Restore context

return

Setup device

Setup PWM

Setup ADC

Cinit_0

Global variables initialization

Setup board protection

Setup interrupts

Background loop

state machine

sfra background funtion

Current loop ISR

Voltage loop plus 

instrumentation ISR

Main Loop

Current Loop ISR (100 Khz)

Voltage loop plus instrumentation code 

(10 khz)

図 3-5. PFC 段のソフトウェア構造

システムの開発および設計を簡素化するために、このリファレンス・デザインのソフトウェアは、次の 4 つのラボで構成され

ています。lab1 と lab2 は、昇圧 DC/DC 動作を検証するように設計されています。lab3 および lab4 は、PFC AC/DC 動
作を検証するように設計されています。

ラボ 1： 開ループ、DC (PFC モード)

ラボ 2： 閉電流ループ DC

ラボ 3： 閉電流ループ、AC (PFC)

ラボ 4： 閉電圧および電流ループ (PFC)

これらのラボについてはセクション 3.1.2.5 に詳述します。リファレンス・デザイン・ハードウェアを使用する場合は、セクショ

ン 3.1.1 で述べたようにハードウェア設定が完了していることを確認します。
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3.1.2.3 C2000 MCU の CLA を使用して CPU の負荷を軽減

CLA (制御補償器アクセラレータ) は、C2000 MCU ファミリの製品に搭載されているコプロセッサです。このコプロセッサ

により、制御 ISR 機能をメインの C28x CPU コアからオフロードできます。

powerSUITE 対応ソリューションにおいて CLA で制御 ISR を実行するには、powerSUITE CFG ページのドロップダウ

ン・メニューから選択します。powerSUITE ソリューションのソフトウェア構造は、ドロップダウン・メニューから選択するだけ

で、CLA にタスクがオフロードできるように設計されています。コードの重複はなく、コードを CLA と C28x のどちらで実行

する場合でも 1 つのアルゴリズム・ソースで実行できます。この構成ではソリューションを柔軟にデバッグできます。

各製品間で CLA の機能は若干異なります。例として、F2837xD、F2837xS、F2807x の CLA は、同時に 1 つのタスクし

かサポートできず、ネスティングに対応していません。この構成では、タスクは割り込み不可能です。CLA には 1 つの 

ISR しかオフロードできません。F28004x の CLA はバックグラウンド・タスクに対応しており、通常の CLA タスクへのネス

ティングが可能です。この構成では、CLA に 2 つの ISR をオフロードできます。

CLA はバックグラウンド・タスクに対応しており、CLA タスクへのネスティングが可能です。この構成では、CLA に 2 つの 

ISR をオフロードできます。F28003x/F28004x の場合には、電流ループ / 電圧ループの制御 ISR (100kHz) と計測 

ISR (10kHz) 両方を CLA にオフロードします。CLA を搭載していない F28002x の場合、両方の ISR を実行できるのは 

C28x のみです。

CLA の詳細については、CLA ハンズオン・ワークショップおよび各製品のテクニカル・リファレンス・マニュアルを参照して

ください。

3.1.2.4 CPU 使用率とメモリ割り当て

GPIO を切り替え、オシロスコープを使用して波形をキャプチャすることで、CPU 使用率を監視できます。各 ISR には、

ISR の先頭で GPIO ピンを “High” に設定し、ISR の末尾で GPIO ピンを “Low” に設定するプロファイリング機能が含ま

れています。高度なオプションを有効にした ISR 負荷は、main.syscfg を構成することで、同じ方法で測定できます。

ISR1 (100kHz) ISR2 (10kHz)

CPU 使用率 42% 10%

図 3-6 に、メモリ割り当て (F28004x) を示します。

図 3-6. TIDA-010062 PFC 段のメモリ割り当て (F28004x)
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3.1.2.5 プロジェクトの実行

3.1.2.5.1 ラボ 1：開ループ、DC (PFC モード)

このラボでは、固定デューティ・サイクルにより基板は開ループ方式で励起します。ラボ 1 をテストするには、出力負荷を 

500Ω に設定します。デューティ・サイクルは dutyPU_DC 変数で制御されます。このラボでは、電力段からの帰還値の検

出と PWM ゲート・ドライバの動作を検証し、ハードウェアに問題がないことを確認します。また、このラボでは入出力電圧

検出の較正も実行できます。図 3-7 にこのラボのソフトウェア構成を示します。このシステムには、電流ループ用の高速 

ISR、電圧ループおよび計測機能を実行する低速 ISR という 2 つの ISR があります。各 ISR で実行するモジュールを図 

3-7 に示します。
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図 3-7. PFC ラボ 1 制御ソフトウェア図：開ループ・プロジェクト

3.1.2.5.1.1 ラボ 1 のソフトウェア・オプションの設定

1. powerSUITE の設定：powerSUITE ページの [Project Options] セクションで次を選択します。

• [Lab] オプションで [Lab1] を選択します

• また、Non-linear Voltage Loop、Adaptive Deadtime などの他のオプションを無効にします

2. 適合ソリューションの場合には、Voltage and Current Sensing Parameters の設定を編集します。

3. [Power Stage Parameters] で、スイッチング周波数、デッド・バンド、定格電力を指定します。

4. ページを保存します。
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3.1.2.5.1.2 プロジェクトのビルドおよびロード

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetconfigs 下で適切な目標構成ファイルが有効になっていることを確認します (図 3-2)。

4. 次に、[Run] → [Debug] または [Debug] ボタン  をクリックします。 この操作によりデバッグ・セッションが起動

します。デュアル CPU デバイスの場合には、ウィンドウが表示され、デバッグを実行する必要がある CPU を選択でき

ます。ここでは、CPU1 を選択します。

5. するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。

3.1.2.5.1.3 デバッグ環境設定ウィンドウ

1. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab1.js スクリプト・ファイルを参照します。このスクリプト・ファイルにより、

[Watch] ウィンドウに、システムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで 

[Continuous Refresh] ボタンをクリックして、コントローラからの値の連続更新を有効にします。 図 3-8 に示すように 

[Watch] ウィンドウが表示されます。

図 3-8. PFC ラボ 1 の [Expressions] ビュー

2.  をクリックしてプロジェクトを実行します。

3. ここでツールバーの [Halt] ボタン ( ) をクリックして、プロセッサを停止します。

3.1.2.5.1.4 リアルタイム・エミュレーションの使用

リアルタイム・エミュレーションは、マイコン動作中に CCS 内のウィンドウを更新できる特別なエミュレーション機能です。こ

の機能により、プロセッサを停止することなく、グラフおよび Watch ビューが更新可能になるだけでなく、ユーザーが 

[Watch] ウィンドウや [Memory] ウィンドウの値を変更して、その変更をシステムに反映できるようになります。

1. マウス・ポインタを水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム・モードを有効にしま

す。
2. メッセージ・ボックスが表示されることがあります。その場合は [YES] を選択して、デバッグ・イベントを有効にします。

この操作により、ステータス・レジスタ 1 (ST1) のビット 1 (DGBM ビット) が「0」に設定されます。DGBM は、デバッ

グ・イネーブル・マスク・ビットです。DGBM ビットが「0」に設定されると、メモリ値とレジスタ値がホスト・プロセッサに渡

されて、デバッガのウィンドウが更新できるようになります。

3.1.2.5.1.5 コードの実行

1.  をクリックしてプロジェクトを再度実行します。

2. 数秒後に突入リレーがオンになり、ラボ 1 でそれを実行するようにソフトウェアがプログラミングされます。検出がクリア

され、デューティ・サイクル 0.5 が適用されます。
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3. [Watch] ビューで、TTPLPFC_guiVin_Volts、TTPLPFC_guiVbus_Volts、TTPLPFC_guiiL_Amps の各変数が更

新しているかどうか定期的にチェックします。

注
現時点では電力が印加されていないため、この値はゼロに近くなっています。

4. 入力 DC 電圧をゼロから 120V まで徐々に上げていきます。デフォルト設定で 0.5PU の安定したデューティ・サイク

ルが適用されるため、出力電圧は昇圧を示します。大電流が引き出された場合、電圧端子が逆接続されていないか
どうかを確認します。そうであれば、まず電圧をゼロに下げ、問題を修正してからテストを再開します。

5. 電圧検出の検証：TTPLPFC_guiVin_Volts と TTPLPFC_guiVbus_Volts に正しい値が表示されていることを確認し

ます。 これにより、基板の電圧検出をある程度検証できます。

6. 電流検出の検証：与えられたテスト条件について TTPLPFC_guiiL_Amps が存在することに注意してください。

図 3-9. PFC ラボ 1：電圧と電流の測定値を示す Watch 式
7. これにより、PWM ドライバおよびハードウェアの接続を基本的に検証でき、ユーザーは dutyPU_DC 変数を変更し

て、さまざまな昇圧条件での動作を確認できます。
8. 終了したら、入力電圧をゼロに下げ、バス電圧がゼロまで下がるのを見届けます。

9. これでこのビルドのチェックは完了し、このビルドが正常に終了した時点で次の項目を検証します。

• 電圧および電流の検出とスケーリングが適正であること

• 電流ループ ISR および電圧ループ計測 ISR におけるラボ 1 コードの割り込み生成および実行

• PWM ドライバおよびスイッチング

問題が確認された場合には、ビルドの問題など解消するためにハードウェアを慎重に点検する必要があります。
10. これでコントローラを停止し、デバッグ接続を終了できます。

11. リアルタイム・モードのマイコンを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] ボタン 

( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイコンをリ

アルタイム・モードから解除します。最後に、  をクリックしてマイコンをリセットします。

12. [Terminate Debug Session] ([Target] → [Terminate all])  をクリックして、CCS デバッグ・セッションを終了しま

す。 

3.1.2.5.2 ラボ 2：閉電流ループ DC

このビルド、ラボ 2 では、内部電流ループが閉じているため、電流補償器 Gi を使用してインダクタ電流を制御します。ラ

ボ 2 をテストするには、出力負荷を 100Ω に設定します。DC バスと出力電圧フィード・フォワードの両方をこの電流補償

器の出力に印加して、インバータのデューティ・サイクル、式 22 を生成します。

� �� u �
 

ac _ cur _meas ac _ cur _ ref _ inst Gi ac _ vol_ sensed
duty1PU

vBus _ sensed (22)

このラボの包括的なソフトウェアの図を図 3-10 に示します。
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図 3-10. PFC ラボ 2 制御ソフトウェア図：閉電流ループ

3.1.2.5.2.1 ラボ 2 のソフトウェア・オプションの設定

1. PowerSUITE の設定：powerSUITE ページの [Project Options] セクションで次を選択します。

• [Lab] オプションで [lab2] を選択します。

• INPUT オプションで入力に DC を選択します。

• また、Non-linear Voltage Loop、Adaptive Deadtime などの他のオプションを無効にします。

2. 他のすべてのオプションがセクション 3.1.2.5.1 で指定されたものと同じであると仮定します。

3.1.2.5.2.2 プロジェクトのビルドおよびロードとデバッグのセットアップ

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。[Run] → 

[Debug] または [Debug] ボタン  を選択して、デバッグ・セッションを起動します。 デュアル CPU デバイスの場

合、ウィンドウが表示され、デバッグを実行する必要がある CPU を選択できます。ここでは、CPU1 を選択します。す

るとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコード

は停止します。
2. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab2.js スクリプト・ファイルを参照します。 このファイルにより、[Watch] ウィンド

ウに、システムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] 
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ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にします。 図 3-11 に示すように [Watch] ウィンド

ウが表示されます。

図 3-11. PFC ラボ 2：閉電流ループ Expressions ビュー

3. マウス・ポインタを水平ツールバーのボタンの上に置き、  ボタンをクリックして、リアルタイム・モードを有効にしま

す。

4.  をクリックしてプロジェクトを実行します。

5. ここでツールバーの [Halt] ボタン ( ) をクリックして、プロセッサを停止します。

3.1.2.5.2.3 コードの実行

1. このプロジェクトは、設定時間 (autoStartSlew==100) を過ぎたら突入リレーを駆動し、検出をクリアするようにプログ

ラミングされています。このラボではソフトウェアがそのようにプログラムされています[Run] ボタンをクリックしてからこの 

autoslew カウンタが 100 に達するまでに、入力電圧を印加する必要があります。入力時に電圧を印加する前にカウ

ンタが 100 に達した場合は、コードをリセットする必要があります。このためコントローラをリアルタイムモードから解除

する必要があり、リセットを実行し、再起動します。3 からの手順を繰り返します。

2. ここで  をクリックしてプロジェクトを実行します。

3. TTPLPFC_autoStartSlew が 100 に達する前に、約 30V の入力電圧を印加します。TTPLPFC_autoStartSlew が 

100 に達するとすぐに、突入リレーが駆動され、PWM 検出がクリアされるのと同時に電流ループ・フラグを閉じます。
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図 3-12. PFC ラボ 2：閉電流ループ動作開始後の Watch 式
4. 入力電流は約 0.7A に制御され、出力電圧は約 46V に上昇します。

5. この操作により、電流補償器設計を検証できます。

6. システムを安全に停止させるには、入力 DC 電圧をゼロまで下げ、TTPLPFC_guiVBus_Volts もゼロに下がっている

ことを確認します。

リアルタイム・モードのマイコンを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] ボタン 

( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイコンをリ

アルタイム・モードから解除します。最後に、  をクリックしてマイコンをリセットします。

7. [Terminate Debug Session] ([Target] → [Terminate all])  をクリックして、CCS デバッグ・セッションを終了しま

す。 
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3.1.2.5.3 ラボ 3：閉電流ループ、AC (PFC)

ラボ 3 では、内部電流ループが閉じているため、電流補償器 Gi を使用してインダクタ電流を制御します。ラボ 3 をテスト

するには、出力負荷を 500Ω に設定します。DC バスと出力電圧フィード・フォワードの両方をこの電流補償器 ++ の出力

に印加して、ゼロクロス周りの PWM ソフト・スタートとともにインバータのデューティ・サイクルを生成します。

このラボの包括的なソフトウェアの図を図 3-13 に示します。
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図 3-13. PFC ラボ 3 制御ソフトウェア図：閉電流ループ AC

3.1.2.5.3.1 ラボ 3 のソフトウェア・オプションの設定

1. PowerSUITE の設定：powerSUITE ページの [Project Options] セクションで次を選択します。

• [Lab] オプションで [lab3] を選択します

• INPUT オプションで入力に AC を選択します。

• また、Non-linear Voltage Loop、Adaptive Deadtime などの他のオプションを無効にします。

2. 過去のビルドの電流補償器をこのラボで再利用するため、ラボの電流ループを調整する追加手順は必要ありません。

3.1.2.5.3.2 プロジェクトのビルドおよびロードとデバッグのセットアップ

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。[Run] → 

[Debug] または [Debug] ボタン  をクリックして、デバッグ・セッションを起動します。 デュアル CPU デバイスの

場合、ウィンドウが表示され、デバッグを実行する必要がある CPU を選択できます。ここでは、CPU1 を選択します。
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するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。
2. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab3.js スクリプト・ファイルを参照します。 このファイルにより、[Watch] ウィンド

ウに、システムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] 
ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にします。

図 3-14. PFC ラボ 3：閉電流ループ Expressions ビュー

3. マウス・ポインタを水平ツールバーのボタンの上に置き、[Continuous Refresh] ボタン  をクリックして、リアルタイ

ム・モードを有効にします。

3.1.2.5.3.3 コードの実行

1. このプロジェクトは、入力電圧が約 75VRMS を上回るまで待機してから突入リレーを駆動し、検出をクリアするようにプ

ログラミングされています。

2.  ボタンをクリックしてプロジェクトを実行します。

3. ここで約 120V の入力電圧を印加します。基板は低電圧状態から脱し、突入リレーが駆動されます。検出がクリアさ

れ、約 0.55A RMS の少量の電流が引き出されます。バス電圧はほぼ 180V です。

4. TTPLPFC_ac_cur_ref_pu を 0.14、すなわち 2.4A 入力まで徐々に上げると、バス電圧は 343V まで上昇します。

図 3-15 に、電圧と電流の波形を示します。
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図 3-15. 閉電流ループ動作開始後の Watch 式、ラボ 3、AC
5. このラボのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイン・

マージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行している状

態で、powerSUITE ページから SFRA アイコンをクリックします。 SFRA GUI が表示されます。

6. SFRA GUI でデバイスのオプションを選択します。例として、F280049M の場合には浮動小数点を選択します。

[Setup Connection] をクリックします。ポップアップ・ウィンドウで [Boot on Connect] オプションのチェックを外し、適

切な COM ポートを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。
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図 3-16. SFRA 実行、PFC 閉電流ループ、開ループ・ゲイン

7. システムを安全に停止させるには、AC 電源からの出力をオフにすることにより、入力 AC 電圧をゼロまで下げ、

TTPLPFC_guiVbus_Volts もゼロに下がっていることを確認します。

8. リアルタイム・モードのマイコンを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] ボタン 

( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイコンをリ

アルタイム・モードから解除します。最後に、  をクリックしてマイコンをリセットします。

9. [Terminate Debug Session] ([Target] → [Terminate all])  をクリックして、CCS デバッグ・セッションを終了しま

す。 
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3.1.2.5.4 ラボ 4：閉電圧および電流ループ (PFC)

このラボでは、外部電圧ループも内部電流ループも閉じています。PI 補償器を使用して、外部電圧ループを 

Compensation Designer で調整します。ラボ 2 をテストするには、まず出力負荷を 0.2A に設定します。

図 3-17 に、このラボのソフトウェア図を示します。
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図 3-17. PFC ラボ 4 制御図：内部電流ループによる出力電圧制御

3.1.2.5.4.1 ラボ 4 のソフトウェア・オプションの設定

1. powerSUITE の設定：powerSUITE ページの [Project Options] セクションで次を選択します。

• [Lab] オプションで [Lab 4] を選択します

• また、Non Linear Voltage Loop、Adaptive Deadtime などの他のオプションを無効にします

2. その他のすべてのオプションはセクション 3.1.2.5.1.1 で指定したものと同じとします。

3. 基板の出力に接続している負荷が powerSUITE syscfg ページに正しく入力されていることを確認します。これは、こ

の負荷の値を電圧補償器の設計に用いるためです。

3.1.2.5.4.2 プロジェクトのビルドおよびロードとデバッグのセットアップ

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。[Run] → 

[Debug] または [Debug] ボタン  をクリックして、デバッグ・セッションを起動します。 デュアル CPU デバイスの

場合、ウィンドウが表示され、デバッグを実行する必要がある CPU を選択できます。ここでは、CPU1 を選択します。
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するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。
2. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab4.js スクリプト・ファイルを参照します。 このファイルにより、[Watch] ウィンド

ウに、システムをデバッグするのに必要な適切な変数が入力されます。[Watch] ウィンドウで [Continuous Refresh] 
ボタン ( ) をクリックして、コントローラからの値の連続更新を有効にします。

図 3-18 に示すように [Watch] ウィンドウが表示されます。

図 3-18. PFC ラボ 4：Expressions ビュー

3. マウス・ポインタを水平ツールバーのボタンの上に置き、ボタン  をクリックして、リアルタイム・モードを有効にしま

す。

4.  をクリックしてプロジェクトを実行します。

5. ここでツールバーの [Halt] ボタン ( ) をクリックして、プロセッサを停止します。

3.1.2.5.4.3 コードの実行

1. このプロジェクトは、入力電圧が約 75VRMS を上回るまで待機してから突入リレーを駆動し、検出をクリアするようにプ

ログラミングされています。

2.  をクリックしてプロジェクトを実行します。

3. ここで約 220V の入力電圧を印加します。基板は低電圧状態から脱し、突入リレーが駆動されます。検出がクリアさ

れ、出力が DC 380V まで上昇します。AC 入力から正弦波電流が引き出されます。図 3-19 に、この段でプログラム

を実行しているときの [Watch] ウィンドウを示します。
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図 3-19. PFC ラボ 4：AC 電圧を印加した後の Expressions ビュー

4. このビルドのソフトウェアには SFRA が統合されているため、ハードウェアを測定して、設計した補償器が十分なゲイ

ン・マージンと位相マージンを提供していることを検証できます。SFRA を実行するには、プロジェクトを実行している

状態で、syscfg ページから SFRA アイコンをクリックします。 SFRA GUI が表示されます。

5. SFRA GUI でデバイスのオプションを選択します。例として、F28004x の場合には浮動小数点を選択します。[Setup 
Connection] をクリックし、ポップアップ・ウィンドウで [Boot on Connect] オプションのチェックを外して、適切な COM 
ポートを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] をクリックします。

6. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できます。SFRA 掃引

が完了するまでには数分かかります。SFRA GUI のプログレス・バーを確認したり、UART の動作を示す制御カード

裏面の青色 LED の点滅をチェックすることで、動作を監視できます。終了すると、図 3-20 のように開ループ・プロット

によるグラフが表示されます。この操作により、設計した補償器が確かに安定していることを検証できます。また、周波
数応答データは SFRA データ・フォルダ下のプロジェクト・フォルダに保存され、SFRA 実行時のタイムスタンプが記

録されます。
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図 3-20. PFC 閉電圧ループでの SFRA 実行

7. これにより、電圧補償器の設計を検証できます。

8. システムを安全に停止させるには、AC 電源からの出力をオフにすることにより、入力 AC 電圧をゼロまで下げ、

TTPLPFC_guiVbus_Volts もゼロに下がっていることを確認します。

9. リアルタイム・モードのマイコンを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] ボタン 

( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイコンをリ

アルタイム・モードから解除します。最後に、  をクリックしてマイコンをリセットします。

10. [Terminate Debug Session] ([Target] → [Terminate all])  をクリックして、CCS デバッグ・セッションを終了し

ます。 

3.1.3 LLC 段ソフトウェア

3.1.3.1 CCS でのプロジェクトの開始

1. CCS (バージョン 10.1 以降) を開きます。CCS を画面上で最大化します。Welcome 画面が表示された場合は閉じ

ます。
2. メニュー・バーで、[Project] > [Import CCS Project] の順にクリックします。ルート・ディレクトリの下にある「…」に移

動し、\C2000Ware_DigitalPower_SDK_X_XX_XX_XX\solutions\tida_010062\ ディレクトリを選択します。

[Projects] タブの下にある llc_F28002x、llc_F28003x、または llc_F28004x が選択されていることを確認します。

[Finish] をクリックします。

3. これで、[CCS Project Explorer] ウィンドウに LLC プロジェクトが表示されるはずです。このプロジェクトは、すべての

必要なツール (コンパイラ、アセンブラ、リンカ) を起動してプロジェクトをビルドします。プロジェクトには、マイコンのハ

ードウェアで実行できる実行形式出力ファイル (.out) を開発するのに必要な、すべてのファイルとビルド・オプション

が含まれています。
4. 左側の Project ウィンドウで、プロジェクト名の左側にある矢印記号をクリックします。Project ウィンドウは図 3-21 のよ

うになります。
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3.1.3.2 プロジェクト構造

プロジェクトがインポートされると、図 3-21 に示すように CCS 内に Project Explorer が表示されます。

この設計のこの段階では、<solution> は llc です。 プロジェクト構造はセクション 3.1.2.2 の ttplpfc と同じです。

図 3-21. LLC ソリューション・プロジェクトの Project Explorer ビュー

プロジェクト・ウィンドウで main.sysconfig ファイル名をダブルクリックします。この GUI を使用して定格電力、インダクタン

ス、容量、検出回路パラメータなど、適合ソリューションのパラメータを変更できます。
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図 3-22. LLC 段の powerSUITE ページ

3.1.3.3 ソフトウェアの流れ図

ソフトウェア・プロジェクトでは、C バックグラウンド C-ISR フレームワークを使用します。このプロジェクトは、アプリケーショ

ンのメインのサポート・プログラムとして C バックグラウンド・コードを使用し、すべてのシステム管理タスク、意思決定、イン

テリジェンス、およびホストとのやり取りを実行します。C-ISR コードは、タイム・クリティカル割り込みサービス・ルーチン 

(ISR) 内で実行され、すべての重要な制御コードを実行します。このコードには、ADC の読み取り、制御の計算、PWM 
の更新が含まれています。C-ISR の制御 ISR 部分は、予備の PWM モジュール・タイマを使用して、50kHz の固定レー

トで実行されます。 図 3-23 にファームウェアのソフトウェア・フローチャートを示します。
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Setup Device

Setup status LED and profiling GPIO

Setup ADC

Setup PWM

Setup Board Protection

Setup Control ISR Interrupt

Background Loop

A1 -> Update dead-band

A2 -> Period / Voltage Slew

A3 -> SFRA GUI Task

B2 -> SFRA background task

B3 -> Toggle status LED

C1 -> System startup

C2 -> Update control values 

from user inputs

ISR1()

Read voltage and current values

(vSec, iPriReso, iSec)

main.c file

Task End

LLC.h file

LLC_HAL.c/h file provide the necessary drivers for 

the LLC.c/h, and the main.c files to run.

Task End

Set GPIO profiling pin

LLC_runISR1()

Clear interrupt flags

Clear GPIO profiling pin

LLC_runISR1()

SFRA Inject

LLC_hybridDutyControl()

If(LLC_LAB >= 2)

PID Controller

Yes

Compute duty cycle

LLC_HAL_updateActuation()

SFRA Collect

If(LLC_enable == 1)

Yes

No

No

main()

Control

図 3-23. LLC 段のソフトウェア構造

このプロジェクトは 2 つの段階的なラボに分かれており、ボードとソフトウェアの学習と理解を深めることができます。

また、このアプローチは、基板のデバッグやテストにも適しています。

ラボ 1： 開ループ制御

ラボ 2： SFRA による閉ループ制御

これらのラボについてはセクション 3.1.3.5 に詳述します。リファレンス・デザイン・ハードウェアを使用する場合は、セクショ

ン 3.1.1 で述べたようにハードウェア設定が完了していることを確認します。

3.1.3.4 CPU 使用率とメモリ割り当て

高度なオプションを有効にした ISR 負荷を測定し、以下のように表示できます。
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ISR1 (50kHz) ISR2 (10kHz)

CPU 使用率 22% --

メモリ割り当て (F28002x) を図 3-24 に示します。

図 3-24. TIDA-010062 LLC 段メモリ割り当て (F28002x)

3.1.3.5 プロジェクトの実行

3.1.3.5.1 ラボ 1：開ループ制御

このラボの目的は、TIDA-010062 LLC 段ハードウェアを理解し、フィードバックなしで PWM 周期を直接調整して出力電

圧を制御することです。このシステムは開ループで動作しているため、ADC での測定値はこのラボでの計測の目的にの

み使用されます。PWM 周期は、[Expressions] ウィンドウを使用して調整します。こうしてこのラボでは、電力段からの帰

還値の検出と PWM ゲート・ドライバの動作を検証し、ハードウェアに問題がないことを確認します。また、このラボでは入

出力電圧検出の較正も実行できます。

図 3-25 に、LLC ラボ 1 のソフトウェア・ブロック図を示します。
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Background Tasks, llc_main.c
C TasksB Tasks
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LLC_runISR1(), llc.h

LLC_vSec_pu

SFRA_COLLECT

SFRA_INJECT

LLC_vSecSetSlewed_pu

Updated by background task A2

LLC_HAL_

readVsec_pu()

LLC_HAL_

readIsec_pu()

LLC_HAL_

readIpri_pu()
IPRIM_TANK

VSEC

ISEC
LLC_iSec_pu

LLC_iPriReso_pu

LLC_vSecSet_pu
LLC_HAL_

update

Pwm

Module()

LLC_dutySet_pu

LLC_PWMDbRedPri

LLC_PWMDbFedPri

tbprd_ticks

cmpa_ticks

cmpb_ticks

dbred_ticks

dbfed_ticks

LLC_update

DeadBand()

Background task A1

LLC_periodRef_pu

Updated by C2()

CMPSS Hardware PWM 

Trip

LLC_periodRef_debug_pu LLC_periodRef_pu

LLC_dutySet_debug_pu

LLC_vSecRef_debug_Volts

LLC_writeVolatile

Float()

Background task 

C1

Clamps user 

inputs and copies 

them to power 

stage variables

LLC_dutyBase_pu

LLC_updateAc

tuation()

LLC_slew()
Background task A2 LLC_periodSetSlewed_pu

LLC_runSFRA

BackgroundTask()

Background task B2

LLC_HAL_

toggleLED()

Background task B3

LLC_service
SFRAGuiSci()

Background task 
A3 LLC_HAL_

toggleLED()

Background task C2

Empty

Bacground task B1

LLC_dutySet_pu

LLC_vSecRef_pu

図 3-25. LLC ラボ 1 のソフトウェア図

ラボ 1 でテストを行う前に、セクション 3.1.1.3 に示すようにハードウェアの設定が完了していることを確認してください。

3.1.3.5.1.1 ソフトウェア設定

1. powerSUITE の設定：[Project Options] セクションの [Lab] オプションで [Lab1] を選択します。

2. 適合ソリューションの場合には、[Voltage and Current Sensing Parameters] の設定を編集します。

3. [Power Stage Parameters] で、スイッチング周波数、デッド・バンド、定格電力を指定します。

4. [Resonant Tank] で、共振タンクのパラメータを指定します。

5. ページを保存します。

3.1.3.5.1.2 プロジェクトのビルドとロード

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. [Debug] ボタン ( ) をクリックするか、[Run] > [Debug] をクリックします。コードがコンパイルされてロードされま

す。
3. プログラムは main() の開始時に停止する必要があります。

3.1.3.5.1.3 デバッグ環境ウィンドウ

コードのデバッグ中にローカル変数とグローバル変数を監視するのは、標準的なデバッグ手法です。これを CCS で実行

するには、メモリ・ウィンドウやウォッチ・ウィンドウなど、さまざまな方法があります。さらに、CCS には時間 (および周波数) 
ドメイン・プロットを作成する機能があり、ユーザーはグラフ・ウィンドウを使用して波形を表示できます。

メニュー・バーで [View] > [Scripting console] をクリックし、スクリプト・コンソールの [Open File] ( ) コマンドを使用し

て、プロジェクト・ディレクトリから setupdebugenv_lab1.js ファイルを開き、[Expressions] ウィンドウのエントリを入力しま

す。 [Expressions] ウィンドウは図 3-26 のようになります。
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図 3-26. LLC ラボ 1 の [Expressions] ビュー

表 3-3. LLC ラボ 1 [Expressions] ウィンドウのエントリの説明

変数 概要

LLC_buildLevel どのラボがロードされたかを示します。

LLC_board_Status 基板のステータスを示します。故障の種類または通常動作

LLC_startFlag この変数を 1 に設定すると、電力段が開始されます。

LLC_vSec_Volts 出力電圧 (ボルト単位)。

LLC_iPriReso_Amps 1 次側タンクの電流 (アンペア単位)。

LLC_iSec_Amps 2 次側 (出力側) 電流 (アンペア単位)。

LLC_periodRef_debug_pu ラボ 1 でスイッチング期間の制御に使用される変数。単位当たり形式

で表されます。

LLC_dutySet_debug_pu スイッチング・デューティの制御に使用される変数。単位当たり形式で
表されます。

EPwm1Regs.CMPA.CMPA ePWM1 の比較 A レジスタ。

EPwm1Regs.CMPB.CMPB ePWM1 の比較 B レジスタ。

EPwm1Regs.TBPRD ePWM1 の時間単位の周期レジスタ。

EPwm2Regs.CMPA.CMPA ePWM2 の比較 A レジスタ。

EPwm2Regs.CMPB.CMPB ePWM2 の比較 B レジスタ。

EPwm2Regs.TBPRD ePWM2 の時間単位の周期レジスタ。

EPwm1Regs.TZFLG ePWM1 の TZ フラグ。デバッグ保護に使用します。

EPwm2Regs.TZFLG ePWM2 の TZ フラグ。デバッグ保護に使用します。

3.1.3.5.1.4 コードの実行

1. ツールバーの <F8> キーまたは [Run] ボタン ( ) を使用して、コードを実行します。

2. これは開ループ・テスト (電圧ループなし) であるため、出力電圧が誤って高くなることを避けるため、負荷を過度に小

さくしないよう注意する必要があります。12V 出力では 10A の負荷を使用します。

3. [Expressions] ウィンドウで、LLC_startFlag = 1 を設定します。コンバータは、デフォルトの LLC_periodSet_pu 値
から動作を開始する必要があり、結果として約 250kHz のスイッチング周波数を生成します。

4. LLC_periodRef_debug_pu 値は [0.55] と [0.65] の間にある必要があります。この値を大きくするとスイッチング周波

数が低下し、負荷に供給されるエネルギーが増加します。開ループでは、出力電圧が上昇するため、基板容量を超
えないようにする必要があります。

5. 入力電圧の設定：DC ソース出力を 0V から 380V に増やします。次の検出されたすべての値が [Expressions] ウィ

ンドウで更新されていることを確認します。LLC_vSec_Volts、LLC_iPriReso_Amps、LLC_iSec_Amps。
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図 3-27. LLC ラボ 1：開ループ動作開始後の Watch 式
6. DC 380V 電源をオフにします。

7. リアルタイム・モードのマイコンを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] ボタン 

( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイコンをリ

アルタイム・モードから解除します。最後に、  をクリックしてマイコンをリセットします。

8. [Terminate Debug Session] ([Target] → [Terminate all])  をクリックして、CCS デバッグ・セッションを終了しま

す。 
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3.1.3.5.2 ラボ 2：SFRA による閉ループ制御

このラボの目的は、ソフトウェア・コード化された制御ループの形で実現される閉ループ・フィードバック制御を使用して、コ
ンバータの出力電圧を調整することです。実行時に SFRA GUI を使用して、システムの周波数応答をキャプチャできま

す。

図 3-28 に、ラボ 2 のソフトウェア・ブロック図を示します。

Background Tasks, llc_main.c
              C Tasks            B Tasks

          A Tasks

LLC_runISR1(), llc.h

LLC_vSec_pu

SFRA_COLLECT

SFRA_INJECT
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Updated by background task A2

LLC_HAL_

readVsec_pu()

LLC_HAL_

readIsec_pu()

LLC_HAL_

readIpri_pu()
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update
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LLC_periodRef_debug_pu LLC_periodRef_pu

LLC_dutySet_debug_pu

LLC_vSecRef_debug_Volts

LLC_writeVolatile
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Clamps user 

inputs and copies 

them to power 

stage variables
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DutyControl()
LLC_dutyBase_pu

LLC_updateAc

tuation()

LLC_slew()
Background task A2 LLC_vSecSetSlewed_pu

LLC_runSFRA
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A3 LLC_HAL_

toggleLED()
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Empty
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LLC_dutySet_pu
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図 3-28. LLC ラボ 2 のソフトウェア図

ラボ 2 でテストを行う前に、セクション 3.1.1.3 に示すようにハードウェアの設定が完了していることを確認してください。

3.1.3.5.2.1 ソフトウェア設定

1. powerSUITE の設定：[Project Options] セクションの [Lab] オプションで [Lab2] を選択します

2. その他のすべてのオプションはセクション 3.1.3.5.1.1 で指定したものと同じとします。

3. ページを保存します。

3.1.3.5.2.2 プロジェクトのビルドとロード

ラボ 1 の手順については、セクション 3.1.3.5.1.2 の手順に従います。

3.1.3.5.2.3 デバッグ環境ウィンドウ

メニュー・バーで [View] → [Scripting console] をクリックし、スクリプト・コンソールの [Open File] ( ) コマンドを使用し

て、プロジェクト・ディレクトリから setupdebugenv_lab2.js ファイルを開き、[Expressions] ウィンドウのエントリを入力しま

す。 [Expressions] ウィンドウは図 3-29 のようになります。
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図 3-29. LLC ラボ 2 の [Expressions] ビュー

表 3-4. LLC ラボ 2 [Expressions] ウィンドウのエントリの説明

変数 概要

LLC_buildLevel どのラボがロードされたかを示します。

LLC_board_Status 基板のステータスを示します。故障の種類または通常動作

LLC_startFlag この変数を 1 に設定すると、電力段が開始されます。

LLC_startupDutySlewFlag スタートアップ・フラグ：デューティ・スルー・ステータス。

LLC_vSec_Volts 出力電圧 (ボルト単位)。

LLC_iPriReso_Amps 1 次側タンクの電流 (アンペア単位)。

LLC_iSec_Amps 2 次側 (出力側) 電流 (アンペア単位)。

LLC_vSecRef_debug_Volts この変数により、ユーザーは目的のレギュレーション電圧を設定できま
す。

LLC_vSecRef_pu 出力電圧リファレンス (pu 単位)。

EPwm1Regs.TZFLG ePWM1 の TZ フラグ。デバッグ保護に使用します。

EPwm2Regs.TZFLG ePWM2 の TZ フラグ。デバッグ保護に使用します。

3.1.3.5.2.4 コードの実行

1. ツールバーの <F8> キーまたは [Run] ボタン ( ) を使用して、コードを実行します。

2. 12V 出力では 10A の負荷を使用します。

3. DC 380V 電源を設定します。電源電流制限を、このテストに適したレベルに設定します。次に、この 380V 電源をオ

ンにします。
4. この時点では、コンバータの Start コマンドが開始されていないため、出力電圧は引き続きゼロになるはずです。

5. 次に、[Expressions] ウィンドウで、LLC_startFlag を 1 に設定します。 
6. コンバータの動作が開始され、出力は約 12V に上昇するはずです。

注
出力電圧が約 12V まで上昇しない場合は、すぐに DC 380V 電源をオフにします。セクション 3.1.3.5.1 
に示すように、最初にラボ 1 の動作を確認します。また、この基板を再度テストする前に、基板の部品を再

検証し、ハードウェアの問題 (部品表 (BOM) と一致しない部品や PCB の製造上の問題など) をデバッグ

する必要が生じることがあります。
7. 負荷を変化させたときの出力電圧および入力電流への影響を観測します。実質的に出力電圧には影響はありませ

ん。同様に、入力電圧を変化させたときの影響を観測します。ここでも、実質的に出力電圧には影響はありません。
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8. PWM ゲート駆動信号、入力電圧、電流および出力電圧など、さまざまな波形をオシロスコープでプローブすることも

できます。この絶縁型 DC/DC コンバータでこれらの高電圧と大電流をプローブする際には、適切な安全上の注意を

払い、適切な接地要件を考慮する必要があります。
9. main.syscfg ファイルを選択し、SFRA を開きます。[Setup Connection] をクリックし、適切な COM ポートを選択しま

す。ボーレートが 57600 に設定されており、[Boot on Connect] がオフになっていることを確認します。 [OK] ボタン

をクリックします。[Floating Point] 演算を選択します。SFRA GUI で [Connect] をクリックします。GUI を接続したら、

[Start Sweep] をクリックします。SFRA はさまざまな周波数の適用を開始し、周波数解析の応答を収集します。

図 3-30. SFRA 実行、LLC 閉ループ、開ループ・ゲイン

10. DC 380V 電源をオフにします。

11. リアルタイム・モードのマイコンを完全に停止するには、2 段階の手順を踏みます。まず、ツールバーの [Halt] ボタン 

( ) を使用するか [Target] → [Halt] の順にクリックしてプロセッサを停止します。 次に、  をクリックしてマイコンをリ

アルタイム・モードから解除します。最後に、  をクリックしてマイコンをリセットします。

12. [Terminate Debug Session] ([Target] → [Terminate all])  をクリックして、CCS デバッグ・セッションを終了しま

す。 
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3.1.4 PFC + LLC 段のデュアル・テスト

3.1.4.1 ハードウェア設定

f28004x および f28002x ベースのソリューションでは、PFC+LLC の 2 段テストを実施するのに追加のハードウェアは必

要ありません。f28003x ベースのソリューションをテストするには、図 3-31 に示すように、2 つの FSI アダプタ・ボード 

(MDSFSIADAPEVM) が必要です。TMDSFSIADAPEVM は、C2000 の FSI 通信ペリフェラルの機能を理解するのに

役立つ評価ボードです。リボン・ケーブルを介して、f28003x controlCARD の J1 ヘッダに 2 つの FSI アダプタ・ボード

が接続されています。スペースが限られているため、図 3-32 で 1 個または 2 個の追加コネクタが必要になることがありま

す。

各 FSI コアには、1 つのクロック信号と 2 つのデータ信号の 3 つの信号が関連付けられています。データは常に送受信

され、各フレーム・フィールドの最上位ビットが先頭になります。マルチレーン送信を使用しない場合は、TXD1 信号と 

RXD1 信号を未接続のままにし、それらの GPIO を他のアプリケーションのニーズに合わせて転用できます。

TIDA-010062 では、TXD0 信号と RXD0 信号のみが使用されます。

FSI クロックは f28004x および f28002x で 50MHz に設定され、f28003x では 60MHz に設定されます。ノイズが大きく 

FSI 接続に影響する場合、クロック速度を下げるオプションがあります。

図 3-31. f28003x ベースのソリューション向け FSI アダプタ・ボード
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図 3-32. f28003x 制御カード搭載コネクタ

3.1.4.2 システム・テスト手順

1. GaN ドーター・カードと C2000 controlCARD を次のようにマザーボードに接続します。コネクタの各ピンへの接続の

詳細については、「1kW、80+ Titanium AC/DC 電源のリファレンス・デザイン」の回路図を参照してください。

• コネクタ Brd1 位置にある 1 枚の GaN ドーター・カード LMG3410-HB-EVM
• コネクタ J1 および J3 に TMDSCNCD280049C、TMDSCNCD280039C、または TMDSCNCD280025C を備

えた C2000 Piccolo controlCARD 
2. リファレンス・ボードの 3 ピン AC 端子を AC 電源に接続します

3. 出力端子を配線で電子負荷に接続し、極性を適切に維持します

4. 冷却ファンを AC 側に配置し、ボードを風にさらします

5. 約 10A の小さな負荷を設定および維持します

6. 電流 / 電圧プローブを接続して入力電流、入力電圧、出力電圧を観測できます

3.1.4.3 TIDA-010062 の FSI ソフトウェア

FSI は、絶縁バリアをまたぐ信頼性の高い高速通信を実現できるシリアル・ペリフェラルです。

1. PFC ソリューションの TTPLPFC_LAB が 4 に設定され、LLC ソリューションの LLC_AUTOSTART が 1 に設定され

ていることを確認します。
2. 1 次側 (PFC) マイコンと 2 次側 (LLC) マイコンは、両方のマイコンが互いを認識するまでハンドシェイクを継続しま

す。ハンドシェイクが完了すると、TTPLPFC_Handshake_Complete_Flag は 1 になるはずです。これは、内部のバ

ックグラウンド・タスクです。フラグが 1 でない場合は、1 次側および 2 次側マイコンの FsiRxARegs.RX_EVT_STS 
レジスタを確認します。

3. PFC 出力電圧が 380V に達すると、1 次側マイコンは自動的にフラッシュ・シーケンスと ping フレームを 2 次側マイ

コンに送信して、LLC を起動します。フラッシュ・シーケンスと ping フレームの詳細については、『TMS320F28004x 
リアルタイム・マイクロコントローラ・テクニカル・リファレンス・マニュアル』、『TMS320F28003x リアルタイム・マイクロコ

ントローラ・テクニカル・リファレンス・マニュアル』、または『TMS320F28002x リアルタイム・マイクロコントローラ・テクニ
カル・リファレンス・マニュアル』を参照してください。 
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図 3-33 に、フラッシュ・シーケンスおよび ping フレーム波形のクロック信号とデータ信号を示します。

図 3-33. フラッシュ・シーケンスおよび ping フレームのクロック信号 (CH1) とデータ信号 (CH3)
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図 3-34 に、ping フレーム波形のクロック信号とデータ信号を示します。

図 3-34. ping フレームのクロック信号 (CH1) とデータ信号 (CH3)

3.1.5 ライブ・ファームウェア・アップデートの概要

3.1.5.1 ライブ・ファームウェア・アップデートの説明

サーバー電源、計測などのアプリケーションでは、ファームウェアのアップデート時にダウンタイムを短縮するために、シス
テムが連続動作するように設計されています。ただし、ファームウェアのアップグレード時には通常、バグ修正、新機能の
追加、およびパフォーマンスの向上などのために、システムが運用を停止し、関連するエンティティにダウンタイムが発生
します。これは冗長モジュールで対応できますが、その結果、システム全体としてのコストは増加することになります。別の
方法として、ライブ・ファームウェア・アップデート (LFU) を実行し、システムの動作中にファームウェアをアップデートする

ことができます。新しいファームウェアへの切り替えは、デバイスをリセットしてもしなくても実行できますが、リセットしないで
実行する場合はその方法がより複雑になります。

セクション 3.1.5.2 ～ セクション 3.1.5.5 では、このリファレンス・デザインでのライブ・ファームウェア・アップデート (LFU) 
の実装方法について説明します。この例では、TMS320F28003x の 2 つのフラッシュ・バンクを使用したデバイス・リセット

なしの場合の LFU の詳細について説明し、CLA で動作するメイン制御ループ、C28x CPU で動作するバックグラウンド・

プロセスを使用した LFU 機能を図示しています。

C2000™ デバイスにデバイス・リセットなしで LFU を実装する際の詳細については、『C2000™ リアルタイム MCU を使

ったライブ・ファームウェア・アップデートのリファレンス・デザイン』デザイン・ガイドを参照してください。
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図 3-35 に、代表的な LFU ベース・システムのブロック図を示します。

Host
Serial_flash_programmer

CLA

RAM

Read
/Execute

Erase
/Program

Flash Banks

LFU request, image

C28x CPU

App
old

LFU flash
kernel

App
new

LFU flash
kernel

図 3-35. 代表的な LFU ベース・システム

3.1.5.2 ソフトウェアの構造

図 3-36 に、F28003x の LFU コンセプトのソフトウェア・ディレクトリ構造を示します。

図 3-36. LFU ソフトウェアのディレクトリ構造

図示のディレクトリには、TIDA-010062 デザインの LFU 実装を示す各種ファイルが含まれており、以下のフォルダがあり

ます。

• /lfu には、LFU 固有のソース・ファイルとヘッダー・ファイルが含まれています。

• /drivers には、HAL (ハードウェア・アブストラクション・レイヤ) のソース・ファイルとヘッダー・ファイルが含まれてい

ます。
• /CCS には、LFU CCS プロジェクトの仕様が含まれています。

• /cmd には、リンカ・コマンド・ファイルが含まれています。
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• /llc には、llc_main.c、llc_clatasks.cla、main.syscfg、その他のヘッダー・ファイルが含まれています。

• /examples には、カスタム・ブートローダ (SCI フラッシュ・カーネル) が含まれています。

3.1.5.3 LLC 段ソフトウェアの LFU

3.1.5.3.1 CCS でのプロジェクトの開始

CCS でプロジェクトを開始するには、次の手順に従います。

1. Code Composer Studio (CCS) 統合開発環境 (IDE) ツール・フォルダ (CCSV12.0 以上を推奨) から CCS をイン

ストールします。
2. C2000Ware Digital Power SDK ツール・フォルダの C2000Ware DigitalPower SDK をインストールします。

注
デフォルト・インストールでは、SDK とともに powerSUITE がインストールされます。

3. [View] → [Resource Explorer] を選択します。TI Resource Explorer 下で、C2000Ware DigitalPower SDK を選

択します。リファレンス・デザイン・ソフトウェアをそのまま開くには (このリファレンス・デザインおよびハードウェアで動

作していたようにファームウェアが開き、基板はこのリファレンス・デザインと全く同じものにする必要があります)
4. [C2000Ware DigitalPower SDK] 下で、[Development Kits] → [CCM Totem Pole PFC TIDA-010062] を選択

し、[Run <Import> Project] をクリックします。

5. これでプロジェクトがインポートされ、開発キットまたは設計ページが表示されます。このページを使用して、このユー
ザー・ガイドやテスト・レポート、ハードウェア設計ファイルなど、リファレンス・デザインに関する情報をすべて参照でき
ます。

6. [Import F28003x LFU DC-DC Project] をクリックします。

7. この操作によりプロジェクトがワークスペース環境にインポートされ、図 3-37 のような GUI の main.syscfg ページが

表示されます。

図 3-37. 代表的な LFU ベース・システム
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main.syscfg ファイルをクリックすると、GUI ページが開いて、PFC 設計の変更可能なオプションが表示されま

す。この GUI を使用して定格電力、インダクタンス、容量、検出回路パラメータなど、適合するコンセプトのパラメータ

を変更します。

LFU の目的に合わせて、以下のオプションが選択されていることを確認してください。

• [LLC Lab] → [Closed Loop]
• [Control On] → [CLA]
• [SFRA Enabled] → [Disabled]

8. 指定された設定が選択されたら、それぞれのビルド構成で、LFU_BANK0、LFU_BANK1 の順序でプロジェクトをビ

ルドします。

注
Bank1 のファームウェアは Bank0 をリファレンスとして使用しビルドされるため、プロジェクトはこの順序で

ビルドする必要があります。

ハードウェア上でのデバッグ手順に関する具体的なラボの詳細については、セクション 3.1.3.5 を参照してください。

3.1.5.4 CCS を使用したカスタム・ブートローダとアプリケーションのフラッシュへのロード

CCS を使用してカスタム・ブートローダとアプリケーションをインポート、ビルド、およびフラッシュにロードする方法の詳細

については、『C2000™ リアルタイム MCU を使ったライブ・ファームウェア・アップデートのリファレンス・デザイン』デザイ

ン・ガイドの「CCS を使用したカスタム・ブートローダとアプリケーションのフラッシュへのロード」セクションを参照してくださ

い。

注
カスタム・ブートローダは、
<C2000Ware_DigitalPower_SDK_path>\solutions\tida_010062\f28003x\examples\fl

ash\CCS にあります。

適用可能なビルド構成には、BANK0_LDFU と BANK1_LDFU があります。

BANK0_LDFU が BANK1_LDFU よりも先にビルドされていることを確認してください。両方のアプリケーションのビルド構

成が完了したら、ブートローダとアプリケーションをデバイスにフラッシュする次の手順に進んでください。

3.1.5.5 CLA で制御ループを実行した状態での LFU デモの実行とテスト結果

デバイスの両方のフラッシュ・バンクにカスタム・ブートローダとアプリケーション・イメージがプログラムされた状態で、LFU 
デモはスタンドアロン・モードで実行できるようになりました。

スイッチオーバーが成功したことは、デバイス上のさまざまな信号、レジスタ、LED で確認できます。

警告
オシロスコープを使用して、PWM ゲート駆動信号、入力電圧、電流と出力電圧などのさまざまな波形をプロ

ーブし、新しいファームウェアが実行されていることを確認してください。この絶縁型 DC/DC コンバータでこ

れらの高電圧および高電流をプローブする際には、適切な安全対策と接地要件に従ってください。

ボードに電源を供給します。この時点で、LED2 (GPIO34 – D2) が消灯し、LED1 (GPIO31 – D1) が点灯していることを

確認してください。これは、Bank0 アプリケーションが実行中のアクティブなアプリケーションであることを示しています。両

方の LED (D1 と D2) が点灯している場合、Bank1 がアクティブなアプリケーションです。PWM ゲート駆動信号がオシロ

スコープに表示されていないことを確認してください。これは、ソフトウェアが Microsoft® Windows® PC からの SCI オー

トボー・ロック・コマンドを待機しているためです。

SCI オートボー・ロックを有効にするには、Microsoft Windows のコマンド・プロンプトからコマンドを実行します。このコマ

ンドは、以前にブートローダとアプリケーションをプログラムする際に入力したコマンドと似ています。コマンドの例は以下の
とおりです。

• serial_flash_programmer_appln.exe -d f28003x -k 
f28003x_fw_upgrade_example\flash_kernel_ex3_sci_flash_kernel_bank0.txt -a 
f28003x_fw_upgrade_example\llc_f28003x_BANK1FLASH.txt -b 9600 -p COM5
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図 3-38. LFU 操作前と後のスイッチング周波数の変化

ここで、controlCARD の LED1 が点滅していることを確認します。これによって、LLC_main.c のバックグラウンド・タスク 

B1 で LLC_HAL_toggleLED () 関数が実行されていることが確認できます。LED2 は、BANK0 にアクティブなアプリケー

ションがある場合は消灯し、BANK1 にアクティブなアプリケーションがある場合は点灯します。

コマンド・プロンプト・ウィンドウには、前に示したのと同じフラッシュ・プログラミング・オプションが表示されます。これで、デ
バイスはもう一方のフラッシュ・バンクに切り替えることができます。もう一方のバンクに実行を切り替えるには、「8 – Live 
DFU」と入力します。これによって、新しいファームウェアが非アクティブなバンクにプログラムされます。完了したら、「0 – 
Done」と入力してプロセスを完了します。フラッシュへのダウンロード中は、バックグラウンド・タスクが停止されるために 

LED1 の点滅は停止します。

デバイスに新しいイメージがプログラムされると、LED2 と LED1 が点灯から消灯 (Bank1 -> Bank0)、または消灯から点

灯 (Bank0 -> Bank1) に切り替わります。これによって、新しいイメージが実行されていることが分かります。

PWM 信号の波形が新しい目標スイッチング周波数 (200kHz) に更新され、緑色 (M1) で示されます。図 3-38 を参照し

てください。

もう一つの確認方法は、DF22 コントローラの新しい係数をプログラムすることです。LFU の前に Bank0 アプリケーション

のシンボルを CCS にロードし、LLC_ctrl_DF22 構造体の内容を観れば確認できます。具体的には、対象となる制御ル

ープ・パラメータ b0、b1、b2 を観察してください。LFU が完了したら、Bank1 アプリケーションのシンボルを CCS にロー

ドすることができ、対象となるパラメータを観察して、新しいイメージのスイッチオーバーと実行、適切な設定を確認できま
す。図 3-39 に、LFU の前後の係数値を示します。

図 3-39. Bank0 と Bank1 の異なるイメージ間での制御ループ・パラメータの変化
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注
テストの目的で、Bank0 の係数は、Bank1 の係数の約半分の値に設定されています。これは、調整が不十分

な補償器 (BANK0) と微調整された補償器 (BANK1) の影響を示すためです。より信頼性の高いテストを行う

ために、設計者は過渡応答分析を実行し、新しいイメージがロードされ、スイッチオーバーされる際の影響や
変化をリアルタイムで監視することができます。
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3.2 テストと結果

テスト結果は複数のセクションに分かれており、定常状態の性能、機能性能の波形とテスト・データ、過渡性能の波形を網
羅しています。

3.2.1 性能、データ、および曲線

3.2.1.1 PFC 段の効率、iTHD、PF

表 3-5 に、AC 230V 入力における PFC 段の効率データを示します。

表 3-5. AC 230V 入力時の PFC 段の効率、iTHD、PF (CTRL および DRV 損失なし)

VIN (Vac) IIN (Aac) PIN (W) VOUT (V) IOUT (A) POUT (W) 効率 (CTRL および 

DRV なし)
効率 (CTRL およ

び DRV あり) iTHD (%) PF

230.00 0.56 108 386.38 0.273 105.48 97.65% 95.80% 11.50% 0.997

229.93 1.301 238 386.39 0.607 234.54 98.41% 97.56% 4.76% 0.999

229.87 1.691 360 386.39 0.919 355.09 98.60% 98.03% 3.55% 0.999

229.8 2.321 481 386.33 1.228 474.41 98.73% 98.31% 2.41% 0.999

229.74 2.799 602 386.41 1.540 595.07 98.82% 98.47% 2.19% 0.999

229.68 3.258 723 386.52 1.849 714.68 98.82% 98.54% 1.82% 0.999

229.61 3.706 846 386.39 2.165 836.53 98.83% 98.59% 1.41% 0.999

229.55 4.237 969 386.52 2.475 956.64 98.78% 98.56% 1.25% 0.999

229.53 4.414 1006 386.31 2.569 992.43 98.65% 98.45% 1.38% 0.999
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図 3-40. AC 230V 時の PFC 段の効率

www.ti.com/ja-jp ハードウェア、ソフトウェア、テスト要件、テスト結果

JAJU751G – SEPTEMBER 2019 – REVISED OCTOBER 2023
資料に関するフィードバック (ご意見やお問い合わせ) を送信

LFU 対応、1kW、80 Plus Titanium、GaN CCM トーテム・ポール・ブリッジレス PFC 
およびハーフ・ブリッジ LLC のリファレンス・デザイン

53

English Document: TIDUET7
Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com/ja-jp
https://www.ti.com/ja-jp/lit/pdf/JAJU751
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU751G&partnum=TIDA-010062
https://www.ti.com/lit/pdf/TIDUET7


POUT (W)

i TH
D

(%
)

0 200 400 600 800 1000 1200
0

0.02

0.04

0.06

0.08

0.1

0.12

0.14

図 3-41. AC 230V での iTHD
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図 3-42. AC 230V での PF

3.2.1.2 LLC 段の効率

表 3-6 に、開ループ・テストでの LLC 段の効率を示します。

表 3-6. LLC 段の効率

VIN (V) IIN (A) VO (V) IO (A) PO 効率 (CTRL および DRV なし) 効率 (CTRL および DRV あり)

385.9 0.324 12.08 10 121 96.61% 95.16%

385.9 0.636 12.05 20 241 98.20% 97.45%

385.8 0.949 12.02 30 361 98.49% 97.98%

385.8 1.262 12.00 40 480 98.59% 98.21%

385.8 1.575 11.96 50 598 98.43% 98.12%

385.7 1.888 11.95 60 717 98.46% 98.20%
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表 3-6. LLC 段の効率 (続き)
VIN (V) IIN (A) VO (V) IO (A) PO 効率 (CTRL および DRV なし) 効率 (CTRL および DRV あり)
385.7 2.200 11.91 70 834 98.25% 98.03%

385.7 2.513 11.89 80 951 98.15% 97.95%

385.7 2.670 11.87 85 1009 97.99% 97.81%
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図 3-43. LLC 段の効率

3.2.1.3 システム全体の効率

表 3-7 に、制御損失のない 2 つの段のシステム効率を示します。

表 3-7. システム全体の効率

VIN (V) IIN (A) PIN (W) THD (%) PF VO (V) IO (A) VBUS (V) 効率 (DRV および 

CTRL なし) (%)
PDRV 
(W)

効率 (PDRV のみ

あり) (%)

230.08 0.623 126.97 9.23% 0.885 12.12 10 386 95.46% 3.106 93.18%

239.85 1.123 249.38 5.35% 0.965 12.09 20 386 96.96% 3.106 95.77%

229.89 1.657 371.67 3.51% 0.975 12.07 30 386 97.43% 3.106 96.62%

229.82 2.328 493.9 2.60% 0.923 12.03 40 386 97.43% 3.106 96.82%

229.76 2.829 616.4 2.07% 0.947 12.00 50 386 97.34% 3.106 96.85%

229.70 3.286 738.5 1.46% 0.978 11.97 60 386 97.25% 3.106 96.84%

229.63 3.805 861.4 1.46% 0.985 11.95 70 386 97.11% 3.106 96.76%

229.57 4.302 984.1 1.07% 0.996 11.95 80 386 96.90% 3.106 96.60%

229.54 4.576 1046 1.23% 0.996 11.92 85 386 96.86% 3.106 96.58%
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図 3-44. システム全体の効率

3.2.2 機能波形

3.2.2.1 起動

図 3-45 に、無負荷、起動時の波形を示します。図 3-46 に、半負荷、起動時の波形を示します。

図 3-45. 無負荷時でのシステム起動
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図 3-46. 50% 負荷でのシステム起動
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3.2.2.2 ホール・センサ

図 3-47 に、AC 入力電流に対応する TMCS1100 ホール・センサの出力を示します。

図 3-48 に、1 次側ホール・センサを流れる実際の電流に対応する ADC サンプル値を示します。これは、ホール・センサ

の直線性が正確であることを証明しています。

図 3-47. TMCS1100 ホール・センス波形

図 3-48. 実際の電流に対応する ADC 値
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3.2.2.3 PFC の動作波形

このセクションでは、PFC 入力時のスイッチング波形を示します。図 3-49 および図 3-50 に、無負荷および 20% 負荷で

の AC 230V 入力時の入力電圧および電流を示し、図 3-51 に、GaN カードを使用した PFC 段のスイッチング波形を示

します。

図 3-49. AC 230V、無負荷入力電圧および電流

図 3-50. AC 230V、20% 負荷入力電圧および電流
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図 3-51. PFC スイッチング波形

3.2.2.4 LLC の動作波形

図 3-52. 電流リップル 50% 負荷
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図 3-53. 電流リップル 100% 負荷

図 3-54. 負荷過渡応答：0%～50%
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図 3-55. 負荷過渡応答：50%～0%

図 3-56. 負荷過渡応答：100%～50%
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図 3-57. 負荷過渡応答：50%～100%

図 3-58. LLC 段のスイッチング波形
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4 設計ファイル

4.1 回路図

回路図をダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してください。

4.2 部品表 (BOM)
部品表 (BOM) をダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してください。

4.3 PCB レイアウトに関する推奨事項

適切なデバイス動作と設計の堅牢性を実現するために、大電流、高速スイッチング回路では PCB レイアウトを注意深く

行うことが重要です。すべてのスイッチング電源と同様に、トラブルシューティングの時間を節約するため、レイアウトの詳
細に注意してください。

4.3.1 電力段に関するガイドライン

次の主要なガイドラインに従って、電力段の部品を配線します。

• 高周波スイッチング電流を含むパワー・パス回路のループ面積とパターン長を最小化します。これは、EMI の低減とコ

ンバータの性能全体の向上に役立ちます。
• スイッチ・ノードは可能な限り短くします。パターン幅が短く最適なため、寄生インダクタンスによるリンギングの低減に

役立ちます。
• dV/dt の電位が高く di/dt の容量が高いトレースは、十分な空間距離とグランド・シールドを確保して、敏感な信号トレ

ースから遠ざけるか、遮蔽してください。
• パワー・グランドと制御グランドは、電源段ごとに分離してください。(電気的に接続されている場合) これらを所定の段

の DC 入力リターンまたは出力リターン付近の 1 点に接続します。

• 複数のコンデンサを並列に使用して電流を共有する場合、レイアウトは両方のコンデンサ・リードで対称になる必要が
あります。レイアウトが同一ではない場合、直列のパターン・インピーダンスが低いコンデンサはピーク電流が高くなり、
熱くなります (I2R)。

• すべてのパワー・スイッチング部品のヒート・シンクをそれぞれのパワー・グランドに接続します。

• TVS、スナバ、コンデンサ、ダイオードなどの保護デバイスは、物理的に保護対象のデバイスの近くに配置し、短いパ

ターンで配線してインダクタンスを低減します。
• IPC2152 に準拠した定格電流で許容される温度上昇と、許容される DC および AC インピーダンスに基づいて、

PCB パターン幅を選択します。これらのパターンは、ヒューズや回路ブレーカなどの電子保護デバイスがアクティブに

なる前に、障害電流 (短絡電流など) に耐える必要があります。

• 該当する規格の要件に従って、回路のさまざまなパターン間の距離を決定します。この設計では、活線、ニュートラル・
ライン、および安全グランドとの沿面距離と空間距離を維持するために、UL 60950-1 安全規格に準拠しています。

• 最終機器に合わせて熱管理を調整します。

4.3.2 ゲート・ドライバ固有のガイドライン

次の主要なガイドラインに従って、高周波の大電流ゲート・ドライバを配線します。

• ゲート・ドライブの出力ピンとパワー・デバイスのゲート間の大電流パターン長を最小限に抑えるため、ドライバ・デバイ
スをパワー・デバイスのできるだけ近くに配置します。

• VDD と GND の間にある VDD バイパス・コンデンサは、パターン長を最短にしてドライバにできるだけ近い場所に配

置し、ノイズ・フィルタリングを向上させます。これらのコンデンサは、VDD から引き出されるピーク大電流に対応しま

す。
• ターンオンおよびターンオフ電流ループ・パス (ドライバ・デバイス、パワー MOSFET、VDD バイパス・コンデンサ) を

できるだけ最小限に抑えて、浮遊インダクタンスを最小限に抑えます。
• ある電流ループから別の電流ループへのスター・ポイント・グランディングにより、ノイズ・カップリングを最小限に抑えま

す。ドライバ GND を、電源スイッチ・ソースや PWM コントローラ・グランドなど他の回路ノードに 1 つのポイントで接続

します。接続されたパスはインダクタンス低減のためできるだけ短くし、抵抗の低減のためできるだけ幅を広くする必要
があります。

4.3.3 レイアウトのプリント

レイヤ・プロットをダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してください。
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4.4 Altium プロジェクト

Altium Designer® のプロジェクト・ファイルをダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してくださ

い。

4.5 ガーバー・ファイル

ガーバー・ファイルをダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してください。

4.6 組立図面

組立図面をダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してください。

5 ソフトウェア・ファイル

ソフトウェア・ファイルをダウンロードするには、TIDA-010062 のデザイン・ファイルを参照してください。

6 関連資料

1. テキサス・インスツルメンツ、『C2000™ MCU を使用するインターリーブ CCM トーテム・ポール・ブリッジレス PFC の
リファレンス・デザイン』 

2. テキサス・インスツルメンツ、『LLC 共振ハーフ・ブリッジ・パワー・コンバータの設計セミナー』 
3. テキサス・インスツルメンツ、『共振 LLC ハーフ・ブリッジ DC/DC コンバータ・ソフトウェア設計ガイド』 
4. テキサス・インスツルメンツ、『共振 LLC ハーフ・ブリッジ DC/DC コンバータ・ハードウェア設計ガイド』 
5. テキサス・インスツルメンツ、『LMG341xR070 ドライバ / 保護機能搭載 600V、70mΩ GaN データシート』 
6. テキサス・インスツルメンツ、『TMS320F28004x Piccolo™ マイクロコントローラ・データ・マニュアル』 
7. テキサス・インスツルメンツ、『TMS320F28004x リアルタイム・マイクロコントローラ・テクニカル・リファレンス・マニュア

ル』 
8. テキサス・インスツルメンツ、『TMS320F28003x リアルタイム・マイクロコントローラ・テクニカル・リファレンス・マニュア

ル』 
9. テキサス・インスツルメンツ、『TMS320F28002x リアルタイム・マイクロコントローラ・テクニカル・リファレンス・マニュア

ル』

6.1 商標
C2000™, Piccolo™, and TI E2E™NexFET™ are trademarks of Texas Instruments.
80 PLUS® is a registered trademark of Ecos Consulting, Inc.
ASIAINFO® is a registered trademark of AsiaInfo Holdings, Inc.
SIMPLE SWITCHER® is a registered trademark of Texas Instruments.
Toshiba® is a registered trademark of Kabushiki Kaisha Toshiba.
Microsoft® and Windows® are registered trademarks of Microsoft Corporation.
Altium Designer® is a registered trademark of Altium LLC or its affiliated companies.
すべての商標は、それぞれの所有者に帰属します。

7 著者について

DESHENG GUO は、テキサス・インスツルメンツのシステム・アプリケーション・エンジニアであり、電力供給産業分野の

一部としてカスタマイズされた電源ソリューションの開発を担当しています。この職務において、パワー・エレクトロニクス、
電力変換、EMI と EMC、電力とシグナルの整合性、アナログ回路の設計に関する豊富な経験を、多くの高プロファイル

組織で活かしています。2007 年には Harbin Institute of Technology with Power electronics から修士号を取得し、高

効率電源の研究と設計に重点を置いて長年にわたって DELTA の DPEC で働いてきました。

MINGHAN DONG は、テキサス・インスツルメンツのシステム・エンジニアであり、産業用部門の電源設計サービスのデジ

タル・リファレンス・デザイン・ソリューションの開発を担当しています。C2000 ファームウェアの設計とアナログ電源回路の

設計に重点を置いています。中国の杭州、浙江大学で電気/電子工学の修士号を取得しています。

JINHAN ZENG は、テキサス・インスツルメンツのアナログ・フィールド・アプリケーション・エンジニアであり、産業分野の

お客様を担当し、最適なシステム・ソリューションを提供しています。この設計の LLC 部分に GaN を採用し、システム全

体のシステム性能を 0.3% 向上させ、お客様に GaN の電力データを提供しました。アナログ・ソケットとスイッチング電源

www.ti.com/ja-jp 設計ファイル

JAJU751G – SEPTEMBER 2019 – REVISED OCTOBER 2023
資料に関するフィードバック (ご意見やお問い合わせ) を送信

LFU 対応、1kW、80 Plus Titanium、GaN CCM トーテム・ポール・ブリッジレス PFC 
およびハーフ・ブリッジ LLC のリファレンス・デザイン

65

English Document: TIDUET7
Copyright © 2023 Texas Instruments Incorporated

http://www.ti.com/tool/TIDA-010062
https://www.ti.com/tool/TIDA-010062
http://www.ti.com/tool/TIDA-010062
http://www.ti.com/tool/TIDA-010062
https://www.ti.com/jp/lit/pdf/TIDUD61
https://www.ti.com/jp/lit/pdf/TIDUD61
https://www.ti.com/jp/lit/pdf/SLUP263
https://www.ti.com/jp/lit/pdf/TIDU257
https://www.ti.com/jp/lit/pdf/TIDU256
https://www.ti.com/jp/lit/pdf/SNOSD10
https://www.ti.com/jp/lit/pdf/SPRS945
https://www.ti.com/jp/lit/pdf/SPRUI33
https://www.ti.com/jp/lit/pdf/SPRUI33
https://www.ti.com/jp/lit/pdf/SPRUIW9
https://www.ti.com/jp/lit/pdf/SPRUIW9
https://www.ti.com/jp/lit/pdf/SPRUIN7
https://www.ti.com/jp/lit/pdf/SPRUIN7
https://www.ti.com/ja-jp
https://www.ti.com/ja-jp/lit/pdf/JAJU751
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU751G&partnum=TIDA-010062
https://www.ti.com/lit/pdf/TIDUET7


アプリケーションに重点を置いており、Huawei での就労経験があります。中国深センの、深セン大学で電子工学の学士

号を取得しています。

改訂履歴 www.ti.com/ja-jp

66 LFU 対応、1kW、80 Plus Titanium、GaN CCM トーテム・ポール・ブリッジレス PFC 
およびハーフ・ブリッジ LLC のリファレンス・デザイン

JAJU751G – SEPTEMBER 2019 – REVISED OCTOBER 2023
資料に関するフィードバック (ご意見やお問い合わせ) を送信

English Document: TIDUET7
Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com/ja-jp
https://www.ti.com/ja-jp/lit/pdf/JAJU751
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU751G&partnum=TIDA-010062
https://www.ti.com/lit/pdf/TIDUET7
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